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Computer Nelwork 2 Network Architecture
Basic Components of a Network . Network Topology
Types of Nelwork

Networking refers to the inter-connection of various devices to share their resources. A
network is a group of devices connected with one another. Cable networks, television
networks and telephone networks are examples of networks.
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Different Types of Network

A network is an inter-connection of machines or people. In other words. a system of
interconnected devices is called a network. A network ties things together. When we create a
network of different devices, it is called metworking. So, networking is the process of

creating network(s).
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COMPUTER NETWORK
A computer petwork is a collect
Known as network

collectn Cl\
; twork. we need

1o establish a computer ne
other devices. These devices
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on of computers and peripheral devices such as printers
components) connected by communication links. In order
at least two or more than two computers and some
are inter-connected using a communication medium such ay

The communication media or links allow the network components to work together. The

network components may be located at remote locations or within the same building.
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@ For Your lﬂﬁt
‘@ Extranetis another form of a network. [t is private to an organisation

* with little external interference but for official purposes only. That
is,itis any Intranet that uses a bit of Internet also.
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Networking of computers is a basic need ol today’s world. L.et us study some advantages ol

anitages of a Computer Network

f

computer networking.

The

Speed : Sending and receiving, files using a computer network 1s rapid. It saves trme.
and 1s more convenient as compared to files which are manually dehvered.
Cost efficient : Indn idually licensed copies of many popular software programs can be
costly. Storing the software on a file server and then making 1t available to the other
compulters connected to it saves money:.
Security : Scnsitive files and programs on a network are protected by passwords. They
can be made available as read only. This helps in avoiding copying of programs.
Centralised software management : Software can be loaded on the main computer.
that is. file server. Thus, it climinates the need (o spend time and energy installing.
updating and tracking files on independent computers throughout the same building.
Resource sharing : Resources such as printers, fax machines, scanners and modems
can be shared by connecting them in a network. This saves space of the work area and is
financially viable.

' ' Juter Network
following are some of the disadvantages of a computer network :
[f the server develops a fault then users may not be able to run the application programs
and chances of data loss are more.

[f the network stops operating then the computers connected to the network cannot be
used, thus affecting the performance of the entire system.
As traffic increases on a network, the performance degrades unless it is designed
properly.
[t becomes diftficult to manage, as the number of computers on a network increase.

BASIC COMPONENTS OF A NETWORK
Computers are connected to a network using some hardware components. Following are the

difficult components of' a computer network.

A server is a computer that manages the network
resources, software and files. It is normally dedicated, that
is, it performs no other task besides the allocated task.

For example, a File server is a computer that manages
storage and retrieval of files. A Print server is a computer

Server

e -

that manages one or more printers required in a network. Workstations

Workstations Connected to a Server
{ FRStation
A workstation 1s a computer intended for individual use in a
networking environment. It is like a personal computer except that it
is connected to other computers as well as to the main computer, that

1s. the server.
Workstation | r— |
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hronph o wired o wirelesn PAN PAN covers a short radims of only o few metres (up to
approxunately 10 meters) Mo uaed 1o share or transfer [tles, songs, cle. USB cable is a
soutce ol wied PAN Blucthooth and Wi I are sources ol wireless PAN. PAN can also be
naed Tor conne b toa ipher level networkcand mternet. 1s relerred as an uplink.

Loval Area Network (LAN)

When computers ane mtcrconnected within a limited peopgraphical arca then it forms 4 fLocal
Atean Network cxample, network within a building, an office, school, cte. It ¢ vers a
tadis ol o lew klomety ey (ip to approxmmalely 1) lilometers).

In addition (o operating meoa himited space, TANs are also typically owned, controllca and
managed by o single pPerson-or-orpantsation. Many 1LANs are based partly or wholly on
wireless technologies, Smartphones, tablel computers and Taptops typically have wireless
networking support bl in.

) T or U In,ga

Y Wi L stands o Wircless Tidelity, 11 represents Wireless 1 ocal Area Network. It vas
developed tor mobie computer devices like Taptops but is now used in PCs. video same
consoles, smartphones, tablots (o exchange data wirelessly over a computer networl.

C U WAPR Wieless Access, Point is a device that connects wireless communication devices

f Lo Torm a wireless nelwor k

Metropolitan Area Network (MAN)

When the computers are miterconnected within the same city, that is, ‘he branches located at
different places in the same city, then it becomes a Mctropolitan Arca Neiwork, Fou cxample,
local libraries, branches of the same school in a city, branches of the same office in a city,
cle. MAN spans over a larper physical arca than a LAN but is smallcr than a WAN, such as a
city. It covers a radius of a range ol 10 kilometers to 50 kilometers approximatcly. It is
typically owned and operated by a single entity such as a bank. a government body or large
corporation. MAN links between local area nctworks have been built with wireless links
using cither microwave, radio or infra-red laser transmission. Most companies rent or lease
cireutts from common carriers because laying long stretehes of cable is expensive.

Thereis another type ol network connecting multiple 1| ANs confined within a campus. (L is
¥ knownas € amipus Area Blel ~Thisnetwork is smaller than MAN.
I 5 . .

For example, different colleges connected in the same university campus, branches of the

i
L sameoffice ina specific region.

Wide Area Network (WAN)

When network s spread across cities, countries Or cven continents, covering a large
geographical arca, then it becomes Wide Arca Network. The Internet is the best example of
WAN as it is the largest WAN covering the globe. In other words, we can say that there is no
any upper limit on our carth planct for WAN. Wide arca networks are often established with
leasced telecommunication circuils, f‘g—'ﬂ
2
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Advantage : [t supports distributed processing, so the increased load will not affect the
system overall.

l)isaf;lwmtage : It does not support centrally managed security. It does not provide the
backing up of files.

@7 For Your ./
>. There is set of rules that governs data communication in a networking environment known 5
a protocol. Afew of them are given below :
* Hyper Text Transfer Protocol (HTTP)
* Simple Mail Transfer Protocol (SMTP)
= File Transfer Protocol (FTP)
* Iransmission Control Protocol/ [nternet Protocol (TCP/IP)

NETWORK TOPOLOGY
The physical arrangement of the cables, computers and other peripheral devices to form a

network is known as a topology.
A few of the network topologies are described here.

Bus topology is made up of a main single cable with the
terminators at both ends. It is the shared communication
medium that makes the backbone of the system.
Computers and the other devices including the server
are connected to this linear cable for communication.
Advantages : The advantages of a network with bus

topology are given below: Bus Topology

@ Itis easy to install.

@ It does not require much cabling.

Disadvantages : The disadvantages of a network with bus topology are given below:

@ If the backbone cable fails, the entire network effectively becomes unusable.
@) It is difficult to identify the problem if the entire network shuts down.

e/ For _Uour {

f'" The data to be delivered in a network is divided into small packets.
Each packet is given a sequence number. The first packet has a ;
destination address followed by the next packet number. The last
packet has an End of file pointer that helps the destination % ‘
==

computer know that the number of packets are complete. t\

Star topology is the most common topology used. Here_all e
the workstations are connected to a central connection
point called a hub. Any data that is sent to the o?h('er
computer, first goes to the central hub and from there it is

redirected to the destination computer.

Star Topology i 11 \
Computer Science e—

 Joy
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ages of using a star topology. They are given below

There are a few advant
grading the hub.

vdvantages :
o add and remove workstations by up

It 15 casy |
e i is casy to install.
Disadvantages : A few disadvantages of a star topology are given below:
e Itrequires more cable length.

e Failures inthe central hub will breakdown the entire network.

N

Ring Topology

[n a ring topology, €very workstation has exactly two
neighbours for communication purposes. All messages travel
through a ring in the same direction either clockwise or
anticlockwise.

\dvantages @ A few advantages ©
below

o It is casier to detect faults in the network.

s  Less number of cable wires arc required.
Disadvantages : A few disadvantages of ring top
o A failure in any cable or device breaks the

f ring topology are given

Ring Topology

ology are given below :
loop leading o breakdown of the entire

network.
# Adding or removing a device/workstation means rewiring and re-routing all the cables.

1. WAN e 2. MAN
3. CAN e 4. HTTP e
5. SMTP e 6. FTP e
7. NIC s 8. TCP
L g, LAN 10. Wi-Fi

A. Tick (/) the right option.
1. With a network itis possible to share
(a) Printers [___l (b) Modems - (c) Softwares | | (d) All of these

2. Advantage of networked computers is

(a) People can hack into other computers
(b) It makes a computer easy to use
12 B

2k
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(c) Viruses spread less easily on networked computers than on stand alone

computers e
(d) You can send and receive information very fast and cheaply. e
A oo COVers a limited geographic distance, such as an office, a building or a
group of buildings in close proximity to each other.
(a) Local Area Network (LAN) [1] (b) Metropolitan Area Network (MAN) [
(c) Wide Area Network (WAN) e (d) Variable Area Network (VAN) []

A Client/Server network

(a) is more secure than a peer-to-peer. -
(b) cannot be used in a LAN., —
(c) is less secure than a peer-to-peer network but cheaper. —_
(d) can only handle two network computers at a time. N

Ona., all of the computers and devices (nodes) on the network connect to a
central device.

(a) bus network [ 1m) ring network i ]
(c) star network [_1(d) none of these [ ]

Fill in the blanks with the correct word.
WAP Star Data Resources Bluetooth LAN MAN Wireless

MN=

W

o

6.

A computer network enables two or more computers to share ... cand o
A network without using wires is called ......................

e teéChnology is a form of wireless communication.
........................ and ................... are the different types of networking.

........................ is a device that connects wireless communication devices to form a
wireless network.
o topology, all the workstations are connected to the central hub.

Match the following.

1. Coaxial Cables a. Manages the network

Z. Workstation b. Terminal for the end user

3. Server C. Wireless transmission channels

4. Peer-to-peer d. Wired transmission channels

5. Microwaves €. Equivalent capabilities of computers.

State whether the following statements are true or false. _

1. A computer network is a collection of computers and other devices. C"

2. Network cards are used to physically attach a computer. :“w

3. In Client-Server network, there is no central server. :

4. Wi-Fi stands for Wireless Fidelity. [ ]
—

A Computer Science



In a ring topology, every workstation has exactly two neighbours for

communication purposes. |
E. Answer the following questions.
What is networking? Give some relevant examples.

List some advantages of networking,
What are the disadvantages of connecting computers in a netwol I

...............................................................................................

..........................................................................
..................................................................................................

F. Give differences between.
Workstation and Server
LAN and WAN
. 2. Client/Server architecture and Peer-to-peer architecture.

#  Visita cybercafe and examine the network there. Prepare a chart of it.
. If there is a network at your school, draw a diagram of the network including attached
systems and devices.

®  Find out the topology of the network used in your school computer lab. Find out the main
reason for implementing that specific topology in the lab. Create an article in MS Word
2007 on the definition, advantages and disadvantages of using that specific topology.
Insert a few relevant pictures using the internet.

I:nmlor‘ ;nlml .
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Number System

?; Lesson Extract 3 |
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< Dacina Numitsey Synfemn

Binan: Number Svstom

O ersion

Lol Menmlwer Syslenmn
Flessorclesc il Mo e Syl
Coomnpeor Artbune e Aoy Anthines

l}l carly davs when there WEIE no means ol countimg, people used o count with the help of
tingers, stones, pebbles, SUCKs, ete. These mcthods were not adequate and had  many
limitatons. Many number Systems were mtroduced with the passape of time, hike ‘ ‘
Decimal number system
Bmary number System
Octal number system
Hexadecimal number system
DECIMAL NUMBER SYSTEM

The need for counting, has paved the path to introduce Decimal number system o which ten
digits 0. 1. 2, 3, ... 9 are used to form any number. Most of our arithmetic operations are
pertormed with decimal numbers.
[t consists of ten digits. i.c. 0 10 9 with the basc 1O, Fach number can be used idividually or
they can be grouped to form a numeric value. li.g., 82, 256, 52.87. ¢tc. The value of cach
digit in a number depends upon the following;:

The face value of the digits

The base of the number system

The position of the digit in the number
For example, the number 547 can be understood in powers ol its base:

7% 10" units ~ 7

4 * 10" tens = 40
)a 5% 10?7 hundreds = 500
547

Observation

The positional value of cach digit increases 10 folds as we move from right to left. In the
above given example; 5, 4 and 7 are the face values of digits and their place values are
hundreds, tens and ones respectively. The place value depends on the position of the digit in

the number.
‘i 15 h
‘ Computer Sclence H
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.1hot was ancient India’s greatest mathematician and an expert in astronomy. He
introduced the concept of O (zero) without which modern computer technology would be
non-existent.

@ Base or Radix of a Number Syste |Thebaseofthenumbersystemisthenumberofdigits
usedinit. E.g., Since the decimal number system uses 10 digits, its baseis 10.

BINARY NUMBER SYSTEM

The Binary number system consists of only two digits— 0 and 1. Sirce this system uses twg
digits, it has the base 2. All digital computers use this number system and convert the data
input from the decimal format into binary equivalent.

Why Binary Numbers are used in Digital Computers?

Since the computer is made up of electronic components, it can have only two states, either
On (1) or Off (0). The data, which is given to the computer is converted into binary form
because a computer understands only binary Janguage. It further converts the binary results
into their decimal equivalents for output.

CONVERSION
Decimal to Binary Number System
The equivalence between binary and decimal numbers can be understood with the given
examples. Follow the rules:
Divide the given decimal number with the base 2.
Write down the remainder and divide the quotient again by 2.
Repeat the step 2 till the quotient IS Zero.

Let us understand the conversion of Decimal number into Binary number with the given
examples:

o Example t: . Example 2:
2 25 Remainder 2 321 Remainder
ﬂ 7 12 - 1 — Least Significant Digit 2 160 - | — Least Significant Digit
2.6 = 0 28 -0 -
23 -0 240 -0
21 - 1 220 -0
0 - 1 — Most Significant Digit 2 10 - 0
Thus (25),, = (11001), 25 -0
L2002 w ]
21 -0
0 - 1—> Most Significant Digit

W © Thus (321),, = (101000001),

Remainders, which are obtained in each step are written in reverse order, to form
e the binary equivalent of a decimal number.

& tnnnulnrrlc_llm ‘



Binary 1o Decimal Number System
Lo convert a binany number 1010 into decimal number, tollow the sy en steps

" sl
Multuply cach binary number with 2 hav e the powet O for umtan poston, startug
trom the extreme night dignt

Increase the power one by one, Aeepmy the base tined as

Sum up all products o pet the decimal number

- L 3 PV e 1 1 "
BN ccample Exarnple

IH T (oo N
(010, | ‘ PN
0 & W Lnus 0 | ' |l ol U O
| x 2 lens ) ‘ I 080
RN Hundreds 0 ‘ > 12 8
s 2 Uhousands N Ihus (1000, = (W,
hus (1010), =~ (10),,
Example 3:
(110001001, Ex2" v 02 o2 a2 o
U\_‘\r{]\,‘"rl\.‘.'l\‘\
LrO 08000 128 286
MR

hus (110001001), = (393),,

) Convert the following Decimal numbers into Binary numbers: .

1. 68 2. 987
|
I
|
1
\

OCTAL NUMBER SYSTEM

The Octal number system consists of 8 digits, .e. 0 to 7 with the base 8. The procedure ot
octal to decimal conversion is similar to “binary to decimal™ conversion. Uhe only difterence
1s the change of base.

HEXADECIMAL NUMBER SYSTEM

This number system contains 16 symbols and, theretore, has the base 16, 1t uses the digits

(0-9) and (A-F).
" 17 ‘
gl Covuterscionce [ S——
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COMPUTER ARITHMETIC/BINARY ARITHMETIC

As computer understands only binary language, the data given by lhc USCT 1S Converfyg N
binary language for processing. This processing may involve various kinds of ;uuhmcnl
operations such as addition, subtraction, multiplication, division, ete. on binary Numberg
Binary Addition

The techmque used to add binary numbers inside the computer is very casy and simp|e. Ik
i

1s performed in the same way as you perform addition with decimal numbers. The folloy;,
table illustrates the addition of two binary digits:

a b at+b=c¢ ‘
0 0 0+0=0

Carry over 1 is shifted to the next )

0 I 0+1=1
place as it happens in decimal
number addition. ] 0 | +0=1
I I |l +1=10
Example 1 Example 2:
Compute (1000), + (111), Compute (11T11), + (1011),
1000 1111 Carry
+ 0111 1111
1111 + 01011
101010
Binary Subtraction 5 b . b_i_J
The rules given in the table must be followed to |
perform binary subtraction: 0 0 0 O_L
| 0 | —(]l
Borrow is taken only when 1 is subtracted 0 | 0-1=1]
from 0. (10-1=1) witha borrot
taken from
Example 1: Example 2: next placel
Compute (1111), - (1010), Compute (1100), — (11),
[ B (10-1=1) Borrow in step >
- 1010 of * (10Y* (10) Borrow in step !
0101 1 1 0 0
— () 0 1 1
1 0 0 1

18]

- Computer Sclence
Book~7




Binary Mu Micatian
Y .‘N_H HC on q h 1 " l‘ R
The rules for performing multiplication using binary

S TR T S : . ) ¥il) = ()
numbers is same g that of decimal numbers. The ) 0 0 v

given table illustrates the multiplication of two binary 0 | %] =0
digits : |
I () | *0 0
| I | %] - |

Compute (101), x (11, Compute (L), x (101),

101 L1l
x 11 x 10|
101 L1
101 x 0000 x
IERRE L1111 xx

001011
Binary Division

The method to perform division of two binary numbers is same as that of de
See the example given below:

5y Compute (110), + (10), Compute (10000111), = (1001),

cimal numbers,

11 <— Quotient 01111 <“— Quotient
10) 110 <— Dividend 100 1) 1000011 |<— Divident
10 1001
010 001111
10 1001
00 <«— Remainder 01101
100
0100 I
100

0000 <«— Remainder
[ ]

© Add the following Binary numbers:

11100 101101
‘ + 10010 + 100100

e
i

.Gompuler Science
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A. Tick (v) the right option.

1. Which number system do we use?

(a) Binary | | (b)Octal |

_ |
(c) Decimal [ ] (d) Hexadecimal |
Who introduced the concept of 0 (zero)?

(a) Charles Babbage

o)

L (b) Aryabhat

O |

(c) Bill Gates L (d) Ada Lovelace L
3. Which number system has ‘8’ as its base?

(a) Octal [ | (b)Binary L]

(c) Decimal | (d) Hexadecimal £l
4. In Binary Subtraction 1—1 equals

(@) 10 Ly (o L ()8 Ly 1 L
5. To perform division on Binary numbers, divide the number by

(a) 2 [[] (4 | | (c)8 | | (d) None of these | |

Fill in the blanks with the correct words.

Binary composed of two 2 10 Decimal 8
The Binary number system has base ...........cccceu.... ;

The ..........ce.c....... number system has base 10.

e

3. Binary Means ... ;

4. Octal Number system consists of ..........c........ digits
5. In Binary addition 1 + 1 equals to .......cccccceennee.

6.

........................ number system is understood by the computer system.
State whether the following statements are true or false.

1. Binary number system uses digits from 0 to 9.
Decimal number system has base 10.

L'_‘._ l
2 1
3. The numbers used in Octal number system are 1 to 7. L ]
4.

The method to perform division of two Binary numbers is not same as that
of Decimal numbers.

5. 1 multiplied by 0 equals to 1. )[
Answer the following questions. N

1. Explain Number System and its commonly used types.

-----
.............................................................................................................................................................................

2. How will you find whether a number is represented in Decimal/Binary/Octal or
Hexadecimal system?

.....
...........................................................................................................................................................................

Compufer-Science
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Why do we use Binary number system in amputers?

. \ & LB W .
£ What arve the rules to onvert a Decimal number into Binary number?

= Convert the following Binary numbers into Decimal numbers.

1. 1011 2100110
*  Perform Binary addition on the following.
L1101 + 10001 Zo 1001101+ 1000101101 L1010 00111
= Subtract the following Binary numbers.
1. 10111 %, L1010 } 10010
-10001 01000 01000

*  Multiply the following Binary numbers.

1. 101x011 21011 x 101 3101010 < 1011
*  Divide these Binary numbers.
L1111+ 11 2111001 101 Jo1010001000E = 11

Make a presentation on Number System. Set a beautiful background and apply formatting
and animation effects on it.

.\

§21
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§  Lesson Extract ? il

Constants and b anables

& Starting QRASIC

= Color SMatemont
< e Satement

S QBASIC Statements o Drenvaing Boxes

S Using Graphics & Cicle Statement

& Sdreen Matements & Crealing sound in QRASIC

QBasic s a programnung language developed by Microsoll e TORS s the successor of
carhier forms of BASIC (Beginners All-Purpose Symbolie lnstructions Code). QBasie 1 an ;
weal programming language tor beginners because ol its simple commands, improved |
programming structures, better graphies and Qexibility. 16 s an integeated deyelopmen
environment (IDE) to write, edit, debug and execute basic programs.

CONSTANTS AND VARIABLES

Constantis

Constants are the values that do not change during the execution ot a program. Constants are
of two types:
Numeric Constants : They are further divided into two types : integer and real constants
Integer constants are positive or negative numbers, without any tractional part, V., 12, 234,
780, cte. Real constants are the numbers with a fractional part. 1.0, 75,5, 46.25, etc,
Character Constants : They arc also of two types: Single Character Constant and String
(Multi-character) Constant. A ‘single character constant” contains only a single character
enclosed in double quotes. F.g. D™ “F" ete. A “string constant” is a sequence of charaeten
enclosed within double quotes. Fog., “Ajay™, “Welcome to Basic Programming™ ete.
Variable

A variable is a meaningful name of data storage location in computer memory. It holds the
value and continues until another value is assigned (o it. A vartable has a type, which s
defined by the kind of value it holds.

Numeric Variable : 1t can hold only numbers that can be of mteger, Hoating decimal, of
long integer type. It is represented by an alphabet. A numeric variable should not contain an
space or symbols like 22\, /, @, :, ; ete.

Example: A= § means the value 5 is assigned to the variable A.

String Variable : A string variable contains values, symbols or text within double quotes
(" ). 1t s represented by an alphabet followed by the dollar sign. g A “AJAY™

22
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lm Ancther way 1o thik of a variable In by imagine a small bucret with a name on Pu
" {

- i r- {* arcl
v an Pl i the b ke (variahle ) hame, Mow take 4 precc ol papir and
;( PP U : F arianlre
® - WIHHe o e o ol antl fll-‘;[; It ante the Inaginary Ducre W the variahle

R TEITE b, o Batie e b Sarmnee Hay f,-“;J‘Hpuf';l carianles can only nold one prece

-

cltarmanion (o falue ) at o e
STARTING QBASIC
I ook tor the Ol o OO Your rlr'J’tr;p and double-click on it 10 start it

ONaac windowy appears with o welcome dhalog box on the sereen. when you open its 4.5
veraon The welcome dinlogr hox does, nol appear in QBasic 7.1, Press Fse key 1o clear the
welcome messape by

Lo execute the commimds m O press FS to run the program. Type the following
Program

Example IR

L PRINT “Welcome 1o the world ol Computers”
I'NI)

W pre CparkBRL 4 ),

QBASIC STATEMENTS

CLS stands for “Clear Sereen™ and s used to clear the screen.

PRINT statement is used 10 display any message or the output of a program. The message
has to be enclosed within quotes but the constants, variables and cxpressions can be
expressed as such. 1o

Syntax : [ Line No | PRINT - Constant - or Variable~ or < Expression - or ““Message”> or
*hstseparated by commas or semi-colons -

(s AT QuickBASIC YA S -

A 50
x 13 100
PRINT “The value of A is™ A: “and BB 15" 3

(It will print the values
Just alter the statement,)

PRINT A, I3 (Iewill print the values

after leaving some spaces. )
PRINTA + B (ICwill print the sum of the values.)
I'ND

E,_f g_r.ur‘ I tl€0 -

The data, variable or expression should be of the same type on either side of the
* statement. If variable is numeric, the data assigned Lo it should also he numeric andsois
~thecase with string variables. E.g.: A 42,A%  “Unionis Strength”
|23 |
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Fhe IOND commmand vl O s tiat AR I T
We can also use INEPUE commmand 1o ask e e
“What bs your same” i 10l al i

GOTO

by cpibe g b gy

fetbianVid ey ‘

e e

Someline:,

JOt il [y prbeapenininn iy i ey i Jron b b Toe gty ibe gppe 14
transter the contral Trom ane stibe ot et bie o
Symtax ¢ [Tane Tlo |G Cr e !l
IF cc.... THEN STATEMENT
FOas wsed o voaboige deesans Livse dd oy e pesul) o) 'rlH‘:lll fors b T il b
followed by VHED o anh Bty 0 0 et 1Y it |

Syntax <1l CONHDITION LD 0 ATIIAL LREIFRIN

I the condition v IO e the estrae oty spee b by 1111
condition v PALSE e control shilis o the 1000 1
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(ETE INPUT “Do you want to print numbers 1 t0 5 YS  (mw

IFYS$ = “yes” THEN e
} PRINT *1”
: PRINT #2»

PRINT “3”
PRINT “4”
PRINT “5”
END IF

crosott Quick BASIC V8 § -

Here, the program asks you a question, If you enter yes, then it prints 1 to 5 on the scroen.
IF...THEN...ELSE

[t is a conditional decision making statement. If the condition given after IF is true.
statement(s) specified after THEN is executed. But if the condition is False. the statemcnt(s)
specified after ELSE will be executed.

Syntax: [F < condition> THEN <statement]> ELSE <statement2 > [END IF]

To print serics with 4 van o between 1 and 4

](}N:l | il vyioiodl | ciill =iy
ﬂ 20 IF N<41 THEN GOTO 30 ELSE GOTO 60

30 PRINTN
40 N=N+4
50 GOTO 20
60 END

USING GRAPHICS

W Microsoft QuickBASIC V4 5 L X ¥

In QBasic, it’s very easy and interesting to create and display graphics on the screen. We use
pixels (picture elements) to draw lines, figures and patterns of different shapes. Before we
proceed with making beautiful graphics, let us first understand the dis v characterisiics of
our monitor. We can have two common modes of display:

Medium Resolution

The computer screen is divided into 320 (horizontal) by 200 (vertical) pixels.
High Resolution

The computer screen is divided into 640 (horizontal) by 200 (vertical) pixels.

Upper Left Upper Right Upper Left Upper Right
(0, 0) (319, 0) (0, 0) (639, 0)
Centre Centre
(160, 100) (320, 100)
(0, 199) (319, 199) (0, 199) (639, 199)
Lower Left Lower Right Lower Left Lower Right |
Medium Resolution High Resolution . 25

Computer Science [ i "
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e/ For Your Iﬂ-gﬁ
*""ﬁf ® The amount of pixels per unit area on the screen is called its resolution.
' ® 1ocate statement moves the cursor to the specified position on the screen,

' ® Locate [row], [column] Locate 5,5

SCREEN STATEMENTS

This statement is used to set the screen resolution. Its syntax is as follows:
SCREEN mode parameter

There are many screen modes that can be used in QBasic. _Every mode has a different
resolution and supports different number of colors. The following table displays the varigys
screen modes with their resolution and the number of colors they support.

Screen 13

320 x 200

Screen Mode ution  No. of Colors Supported
Screen 1 320 x 200 4
Screen 2 640 x 200 2
Screen 7 320 x 200 16
Screen 8 640 x 200 16
Screen 9 640 x 350 16
Screen 10 640 x 350 2
Screen 11 640 x 480 2
Screen 12 640 x 480 16

256

Screen 0 : This mode can be used only for text. No graphics can be created in this mode, all the
other modes can be used to create graphics. The default mode of the screen is mode 0.

For Your Inﬁo

‘@ © Toseta point from where a particular drawing should start on the screen, PSET
. statement is used PSET (X, Y), C.

| ® X refers to column and Y refers to row co-ordinate and C refers to color code.

~ ® We canuse $, ! and # signs in a variable name.

v i = p— e T i s R e i e - _\
COLOR STATEMENT

This statement is used to set attractive screen colors for displaying the text and the graphics.
Its syntax is as follows:

COLOR parameter f
COLOR parameter f, parameter b

(26}
_‘- _L'J_"i‘
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Where parameter f specifies the foreground color and parameter b specilies  the

background color. There are 16 color options for background and forcground colors.
specified by the values 0 to 15.

jackKground Colp *hart

ik

0. Black 4. Red 8. Dark Gray [2. Light Red

I. Blue 5. Magenta 9. Light Blue 13. Light Magenta
2. Green 6. Brown 10. Light Green 14. Light Yellow
3. Cyan 7. Gray 11. Light Cyan 15. White

Let’s create a programs to demonstrate the use of Color statement

CLS ! = 0A\QBASIOO8 EXE

COLOR 2 i
PRINT “Foreground color is ‘Green’™

(wmDA\QBASIC\GH ExE .

(Example JOBS T — |

- COLOR 14, 2 ' '

PRINT “Foreground color is ‘Yellow’ and
Background color is ‘Green’”

To change the background color of the whole screen, write the CLS statement after Color
statement.

SERE COLOR 14, 2 ;
- CLS |
ﬂ PRINT “Foreground color is ‘Yellow’ and |
Background colour is ‘Green’” :‘
LINE STATEMENT

The LINE statement is used to draw a straight line between two points on the screen.

For better output and proper colors, we should choose the screen mode that supports all the
16 colors given in the chart.

Syntax: LINE (X1, Y1) - (X2, Y2), COLOR
Where (X1, Y1) and (X2, Y2) represent the start and end coordinates of a line drawn in the
specified color.

avforuour Inpp

To draw vertical line, x-axis co-ordinates will remain the same for both starting
* and ending points of the line. _ _ ’
- Similarly, for drawing a horizontal line, only the x-axis co-ordinates will change
and y-axi,s co-ordinates will remain the same. To draw diagonal line on the screen.

“both*x’ and ‘y‘co-ordinatele]_cthﬁS?-_ S v

‘ C RISy &
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A 4

(Rxempie

VINY (Lo,

U TR RS

~ P prowiam wall diaw o blae e Gome the pomis 1o, M0 all the way (o (he pomt
L G
- Lot duaw an isosceles triangle with hovizontal base.
NURVEN IMMWN —
VOLOR A4, LY
LN
PRINT ™ Vs a Diangle™
LINY (1o, 30) (080, 180), *
LINE (O30, 18OY 0, TR0y, 2 ‘ -
LINE (O, 180) (o, 30y, 1
EXD L
DRAWING BOXES
ST With Uine statement, we ean also draw boves, (00, 60) (130, 60)
SUREEN A 1
COLOR 3 1S
- CLS
LINE o0, oY - (130, 100), 6, B
Ihe ier B wdwates the box option. ln thas _
statement, the coordinates (00, 00) and (130, 100) (D C
e the oppostie comers of the rectangle, (60, 100) (130, 100)
Sat g 1o fill the box with the desired color shade, add  Eveecommscs AR
BE (box o) option
SCREEN ~
B COLOR &, 1§
CLS
PRINT “This 1s a Rectangle™
_;\};koﬁ,oﬂ\ (130. 100), 6, BF
With DRAW

command. you can start a drawing from a fixed point which is

With PSET command and move around on the screen and draw straight D‘recmﬁ" string
3 _‘.-: dn o Y ons \\1thout bpe(‘]f\]no anmny ]JI\G'I co- Ord]nates H E
Syntaxy DRAW “Directionstring”
CLS . B
PSET(80.80 G G
DRAW “R120 H60 G60 2

Q 120 \.""‘ d*av. 3 120 pinels straic'ht line in the right direction H60 and GE)O will draw lines of

D i

.
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CIRCLE STATEMENT

The Circle statement is used to draw a circle, ellipse or an arc of a circle.
Syntax: CIRCLE (x, y), r, p

The coordinates x and y specify the centre

location of a circle on the screen, ‘r’ gives PAINT statement fills an object with a color.
the value of the radius and 'p’ specifies the

Syntax : PAINT (x, y), color, bordercolor
color code.

SCREEN 7 WMosoh Quadksicvas e
COLOR 14, 5

CLS
PRINT “This is a Circle”

CIRCLE (160, 100), 70, 15
END

CREATING SOUND IN QBASIC
Beep Statement

If you want to add the beep sound, use BEEP
statement is given below:

-~

INPUT *“Press Enter to hear a beep”, AS
BEEP

statement. The syntax of using the BEEP

Play Exarnple

2 PLAY “e8 d8 c8 d8 e8 e8 e4™
It is used to generate musical notes. The B
codes used to produce different musical % ;:;‘)Y c8 d3 e8 f8 g8 a8 b8 c4
notes are as follows:
. , - 2’5 *n
¥ (ole}:) ﬂour srain S .
—_—
A. Tick (V') the right option.

1. Values stored in the program that do not change during program execution are called

(a) Variables ] (b) Constants ] (c) Operators L1l (d) Names .
A statement is used to set the screen resolution.

(a) Drawing Boxes | | (b) Color __, (c) Screen L (d)Print
3. No graphics be created in ..............c.......... mode.

(a) Screen 2 [ ] (b) Screen5 [] (c)Screen0 (] (d) Screen 1 ]

29 |
P .Lil g
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B.

Ihe statement displays message or output of a program.
la) CLS . (D) PRINT L1 (c)GOTO L (d) ENTER L
Fodeaw a b box, the letter 15 used with line co-ordinates.
(a1 D) (B L (A L) L]
il in the blanks with the correct words.
M. Then Line

John G. Kemeny  Thomas EKurtz  Dollar String

ariable contains value, symbols ar text within double quotes and 1

Lby an alphabet tollowed by 51¢n
signed by professor and in 1964

.....

statement is used to draw a straight line

State whether the following statement are true or false.

ands for Beginners All Purpose Symbolic Instruction Code.

Lants are only positive numbers.

ground color code tor Gray coloris 7.

.
|
i
p——
G
itement s used to draw a circle 11

tion mode, the computer screen is divided into 320 = 200 pixels. |

-“

r the following questions.

idin

hiterence between IFE._THEN and IF...THEN.. .ELSE statements’ £ p

yrectangle’ Explain with an example
o ] :

! PSET statement?
tand by the term screen modes?
' Herence between B and BEF opuons used with LINE statement”?

e ot INPUT statement?

30
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Write QBASIC programs to draw the following geometrical shapes:

I. Squre

Z. Rectangle
3. Circle

4. Line

Solve the following crossword with the help of the hints given below:
ACROSS

N
1. Checks for two condition (3)
3. Used to give values to a variable (3) K F :
5. Checks for two condition (2) g
. Anumeric data type (7) !
/. Used as comment (3) R
4. Displays the output (5)
DOWN ml T
Z. Negates the result of a condition (3)
3. A numeric data type (4)
“. A counterloop (3, 4) U
9. Takes data from the user (5)

g@m‘ﬂﬁir

Write programs for the following:

To find the sum of squares of odd numbers up to 10 terms.
To draw an equilateral triangle.
To draw three concentric circles with equal distance between them

. Gomputer Sclence
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i LlessonExtract ____ j;:]
The FOR...NEXT Loop “  WHILE...WEND Statement
FOR NEXT with STEP DO UNTIL....OOP Statement
NESTED FOR...NEXT  Exit
Looping means repeated execution of a statement or a set of statements. Z
Let’s understand with the help of an example : Suppose your instructor orders you to ‘
: - take 10 rounds of a ground to warm up yourself. The very first thing which you will

do, will be, to fix a starting point and then start running. On reaching the starting
point again, you complete a round. Then you take second round, and so on. This

way you keep track of number of rounds until the process is completed. The process
which goes in your mind is that you set a value (control variable) in your mind and
keep on incrementing it until the process is completed.

o For example: Let’s say the control variable is C, which starts fresh from the starting number.
;‘ This number is usually 0 or 1. When you complete the first round, value of C becomes 1,
after sccond round its value becomes C=C + 1, i.e. 1 + 1 =2, and so on. This value has to
be incremented every time the required process is repeated. After incrementing, the control

variable (counter) has to be checked against the maximum limit of the number of the
repetitions required.

[he advantage of using looping technique in programming is that it reduces the number of
instructicns and also the memory space. Consider the following examples:

Example i1

LET A$ = “GOD BLESS YOU”

20  PRINTAS The output will be
'ﬂ 30 LET BS = “GOD IS GREAT” printed infinite times.
40  PRINT B$
50 GOTO 20
60 END
Now, look at the following example, which prints “THANK YOU’ 10 times by using
counter.
10 A=l (Initializing the counter)
20 LET X$ =“THANK YOU”
30 PRINT X$
40 A=A+1 (Incrementing the counter)
| 50 IFA<=10THEN GOTO 30 (Checking for the maximum limit)
321 60 END

| &
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A loop is, thus, used to repeat a block of
following loops are available in QBASIC:

®  The FOR..NEXT Loop

®  WHILE...WEND

The FOR statements are best used to perform a loop a specific
number of times. However, the Do.... and WHILE....WEND statements
are best used to perform a loop an undetermined number of times.

Statements a specific number of times. The

THE FOR ....NEXT LOOP

The process of using multiple counters
repeating a program segment in g |
FOR...NEXT statement. This also reduc

Syntax: FOR < control variable > = < i

in large programs is very tedious. The process of
00p can be simplified and controlled by using
es the length of a program.,

itial value > To < final value >

{Statement}
NEXT <control variable >
Program to find sum of 10 numbers. START
ﬂ REM CALCULATE SUM OF 10 NUMBERS SUMjO, =1 2
- CLS I
SUM =0 INPUT N
FORI=1TO 10 SUM:éUM-FN
INPUT N I '
SUM = SUM + N p.
NEXT ] .
PRINT SUM T I=10
END | Yes
PRINT SUM

An Accumulator is a variable that stores the sum of the numbers entered during the
+ execution of a loop. E.g., Sum = Sum + N.

'
f For Your Iﬁ&J‘ s

The following steps are involved in executing the FOR.. NEXT statement: |

® The control variable is assigned an initial value and a final value. The dlffe¥ence
bet?veen the final and the initial value specifies the number of times the loop will be
executed. -

®  The set of statements between the FOR..NEXT statement is executed. |

®  The NEXT statement increments the value of the control variable by one and shifts the

1.
program control back to the FOR statemen @

‘ Computer Science H
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[he new value of the control variable is compared against the [inal value specifie

din
FOR statement. I it is still less, then the whole process is repeated.

]

[t the value of control variable exceeds the final value, the statcimens
statement 1s executed.

SO0 Program to print table of 12 (up to 5 times only).

CLS
. FORA=1TOS
=

®  PRINT 12 * ™ A: e " 12FA
NEXT A
END

-

\ Counter is a variable that keeps track of the ‘"number of limes & particular instructio
* Or a set of instructions has been executed in a loop. It is also called

Program to display your name nine times on the screcn,
@ €LS .

3 REM PRINT YOUR NAME
# & |INPUT“NAME PLEASE"; N$

FORX=1TO9

PRINT NS

NEXT X

END

alter the Ny,

C ontrol Variable.

Program to create multiple address labels.

- 10 REM PROGRAM TO PRINT MULTIPLE ADDRISS | ABLLS
o 20 INPUT “ENTER YOUR NAME™: A$

4 w 3 INPUT "ENTER HOUSE ADDRESS™ BS
4() INPUT "ENTER CITY™; €S
50 PRINT
60) FORN=1TO2
70 PRINT AS; TAB(40); AS
%() PRINT BS; TAB(40), BY
90 PRINT CS; TAB(40); €S
100 PRINT
110 NEXTN

oM icr ft ©) KRASIC v4.5 [
N IR s ).

120 INPUT “PRINT MORL -YLES/NO™; Y$
130 IFYS “YES”TIHEN 20
140 END

Computer Sclence .



- -

FOR...NEXT WITH STEP

By default, the NEXT statemen( increments the value of the control variable by 1. but we can

increase or decrez.ase the value as per our choice using STEP statement. STEP value 1s
optional and can either pe positive or negative,

Syntax:
FOR <CONTROL VARIABLE> — <INITIAL VALUE> TO <FINAL VALUE> STL:P <n>

Program to print first five odd numbers. = Mcrosoft QuickBASIC V4.5 Mead
el CLS ' |

W)\ FORL=1TO 10STEP?
s @& pPRINTL

NEXT L

END

Program to print numbers between 25 and 5 with a decreasing step of 5.

. CLS | @@ Microsoft QuickBASIC V4.5
)y FORN=25TO 5STEP -5 B
s - il

ﬁ PRINT N
NEXT N |
END

Fross any key to conlinue

clgeelld  Program to print numbers starting from 30 and

¥ = then with a decreasing value of 5 T T T )
[ 10 CLS
d @& 20 B=-5 o

30 FOR X=30TO 1 STEPB

&

L §

40 PRINT X
50 NEXT X
60 END
In this case, B is assigned the value
=5, hence the values are decreased
in step of 5. While using a negative number with the STEP
statement, the initial value in FOR statement should be
NESTED FOR...NEXT more than the final value as shown in the examples.

The use of a FOR..NEXT statement within another FOR..NEXT statement is known as

nested FOR...NEXT statement. The FOR..NEXT which lies outside or encloses the second

FOR..NEXT statement is called Outer Loop. The one, which lies inside is called [nner Loop.

®  You can have maximum of 9 loops within a loop and every loop should be defined

completely within the outer loop. o

®  The same control variable cannot be used in different loops.

®  Firstly, the innermost loop will be executed and then the outer loop. ,.._.'35
g CompulerScionce P—
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Syntax:
. START
10 FORI=1TO 10 l
20 FORJ=1T0 10
30 l
40 FORI=1TO 20 FORI=1TO 20
50 '
60 ‘ NETT |
IFEYX
" NEXTI _ NEXT J
30
90  NEXTI | STOP
| Program to print the tables from 20 to 17. Wioso QoS YAs - W
o3 10 FORI=20TO 17 STEP-1
200 FORJ=1TO 10
o R 30 PRINTL# J, =, 14
40 NEXTJ
50 PRINT
60 NEXT I
70 END

WHILE...WEND STATEMENT

Sometimes, a loop has to be executed repeatedly while a given condition remains true. In
such cases, WHILE... WEND statement is used.

Syntax: WHILE condition

Statement(s)

WEND
10 CLS
‘\ﬂ WX =20
30 WHILE X < 25
) 40 PRINT X
50X =X+1

60 WEND
70 END

. To begin with, the value of X is 20. The condition (X < 25) will be checked.
. Since the condition is true, the current value of X will be displayed.
The value of X becomes 21, as it has been incremented by one.

. WEND statement shifts the control back to the WHILE statement.
=

& Eﬂlllllgt.ﬁlll'l_slflilll:l ‘
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-’ Won X 255 will be checked agamn. It the condition 1s 1T nirol
Noo 40 & S0 but 1t the condition 1s false, the controfl shuyt!
1 11L .'-":l \'\I}
PO UNTIL...LOOP STATEMENT
\ 2 maimns false, of

v De executed rcpmlcdl_\ while a given condiion re
ses, DO UNTIL . LOOP statement 1s used

syntax: DO L NI conditton
'\' ¥
| OH)OP
’ ryle O] S
") X )

N 3ODOUNTIL X -23
A 10 PRINT X
SON N
60 1 OOP
70 I'ND
[o begim with, the value of X is 20. The condition (X - 25) will be checked.
Since the conditon s talse, the current value of X will be displayed.
[he value of Xobecomes 21, as it has been incremented by one.
| OOP statement shifts the control back to the DO UNTIL statement.
| he condition (X - 25) will be checked again. If the condition is false. the control
repeats the statements no. 40 & 50 but it the condition is true, the control repeats the
statements no. 40 & 50 for last time and then shifts to the next statement after LOOP.

Sometimes. we wish to execute a set of statements once and then repeat these statements
only 1t the oiven conditon is true, DOL..LOOP WHILE statement 1s used in this scenario.

Syntax:
DO

'
I

Statement(s)

[ OOP W HILE condition

m 10 CLS W Microseft QuickBASIC V4 § -
20X =20
30 DO
40 PRINT X
50X=X+1
60 LOOP WHILE X > 25 —
70 END —

‘ clnpﬁzz:_:lml H
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This program will print the value of X once, then check for the condition. If the

condition is true. it will repeat the statement within DO Loop. If the condition is false, ;,
will not repeat the statements.

The point to be understood here is that, although the condition was false, it executed the
statement once.

Change the condition to X < 25. Run the program and notice the result.
EXIT

Exit command is used to come out of a loop before the expected number of executions. Exit
command is used followed by either FOR or DO.

-

© Print the square of numbers from 1 to 10 using FOR...NEXT Loop.

)

© Print the odd numbers from 20 to 1 using FOR...NEXT loop.

:"g‘;a‘? - OOSt _I Qur g rain
——
i. A. Tick (V) the right option.
. A ... loopis generally used as a counter loop when you know exactly how many
times you need to execute the loop.
(a) FOR...NEXT [ (b) DO..LOOP WHILE L]
(c) DO UNTIL..LOOP ] (d) WHILE..WEND -
Z~. A .. ... variable keeps track of the ‘number of times’ a particular instruction has
been executed in a loop.
(a) CONTROL | (b) NEXT . () FOR _ (d) WHILE 7
= A . ... statement combines the initialization and checking steps of counters in a
single statement.
(a) DO [ ] (b) WHILE [] () FOR [ ] (d) NEXT =0
A . statement shifts the control back to the WHILE statement.
(a) WHILE ___(B)WEND __ ()DO __ (d)NEXT -
t\_ B. Fillin the blanks with the correct words.
' FOR....NEXT [nitial NEXT STEP Final Control
'- The ........... variable keeps track off the number of times a process is executed.
7. FOR statement is always used along with the ................... statement.
The control variable is assigned an .............. and ............... value in FOR..NEXT statement.
B sssaisamsiien statement increments/decrements the value of the control variable.

Compuler Science
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All the statements, which are to be executed in a loop, come in between
statements

State whether the follow ing statements are true or false.

7

-5

g
D

5.

0,

Looping technique reduces the number of instructions.

The same control variable can be used in different loops.

In Nested loop, the innermost loop will be executed first then the outer loop.
There can be maximum 9 loops within a loop.

WEND clause is used with FOR statement.

STEP valu nnever be negative,

Answer the following questions.

1
i

(\
.

What is looping? Describe the types of looping with examples.

What is the use of STEP in H)RNhXTloop"

What is nested loop?

What is the difference between FOR..NEXT and nested FOR NEXT loop?

Wlmt is the difference hetween WHILE WEND and DO UNTIL..LOOP?

Why do we use Exit Command? Give example.

Sarah wants to generate an even number series from 10 to 20. Which loop should she
use? Write the code for this program.

Reema has been given a task of writing the multiple of 7 from 70 to 140. What statements
should she write Lo display these on the QBASIC screen?

Give the output of the following programs:

CLS 2. M=1
FORY =1to 50 step 5 Do UNTILM > 10
PRINT Y PRINT M
NEXTY M=M+1

LOOP

|39 i
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?i____ Lesson Extract L:]

¢ Database and DBMS « Parts of MS-Access Database Interface Window
% Advantages of G Dotabase « Components of MS-Access Database
% Levels of a Database + Exiting MS-Access

¢ Starting MS-Access 2007

Data and information are important components of a computer system. Data itself has no
meaning. Data simply refers to raw facts and figures. These may be in the form of numbers, |
alphabet, images, sounds or a combination of these. We provide data as an input for a
computer which is processed by the CPU and we get the information as an output. Data
refers to the raw facts while information is the processed data. Data is organised in a
database and managed by the DBMS. Let’s discuss about database and DBMS.

DATABASE AND DBMS

A database is a system for collecting and organising data. It can store information abou
people, items, activities, etc. Many databases begin in the form of a list in a word-processing
program or spreadsheet. As the list grows bigger, duplications and mismatching begin to
appear in the data. This gives rise to difficulty in understanding the data. Therefore, data is
organised and stored in a systematic way in a database. Hence, a database is defined as an
organised system to store and maintain data. For example, a list of names of students and the
marks obtained by them is organised in the form of a table is a database.

A database cannot be organised and maintained in a word processor. A spreadsheet provides
limited features for databases. So, we need a diiferent application software to manage
databases. The application software that creates and maintains a collection of databases is
called Database Management Sv:tem (DBMS). A DBMS manages all the functions of a
database. MS-Access, one of the software of MS-Office is an example of DBMS.

/‘@Foruourf"f"

MS-Access is, in fact, a RDBMS (Relational Database Management
: System). Oracle is another popular RDBMS used exclusively for the

i development of business information systems.
I e e e e e S e [ = e 4

ADVANTAGES OF A DATABASE

There are several advantages of using a database. Without a database, you cannot store and
access huge amount of data required for business and other applications. Many database
solutions are available for various business needs, ranging from storing customer
information in hosting a website. A database provides us with the following benefits:

Bl ComlerSclonce
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1. Saves Time : Instey

: 'stead of searching through the endless piles of paperwork, a database
locates information

: 1on with the help of a simple query. A user can enter specific keywords
in order to find Information. For example, when you enter a keyword in Google search
engine, the required informatiop is searched from a collection of databases.

2. Saves quey : Small business groups always look for cost cutting methods without
COMPIomising on quality. A database requires higher initial investment, howeve:. over
the long fun, 1t saves money by improving the efficiency of all employees, providing
better services to customers and saving on paper costs.

3. Reduces Data Redundancy : Duplication of data is reduced in a database as yov can
arrange the data in g particular order. For example, in a library the name of a bo.!" may

occur under the author’s name and its ISBN number. However, with the help of DBMS
the redundant data can be removed.

4. Facilitates Sharing of Data : Large companies can benefit from databases when

infonnatiqn needs to be provided to various users through a network. For example, a
bank having several branches shares information through data communication and
allows you to withdraw money through an ATM (Automated Teller Machine).

S. Ensures Data Security : File cabinets are not safe as they can be stolen, accidentally

destroyed, or.lost. Databases secure the valuable information through passwords and
other mechanisms.

Maintains Integrity : DBMS maintains integrity by keeping some constraints when the
data is entered. These constraints are the rules that are designed to keep data consistent
and correct. They act like a check on the incoming data.

LEVELS OF A DATABASE

A database consists of tables or files. A table consists of records and a record consists of
fields. Data organised in columns of a table is called Fields (Name of Student, Marks

Obtained, etc.) and data organised in rows is called Records (Vivan, Nakul, etc.) as
illustrated below:

A Database File or Table Showing the Result of Various Students

Name of Marks Maximum Percentage Result
Student Obtained Marks
Vivan 140 200 70.00 Pass
Nakul 150 200 75.00 Pass
Manu 170 200 85.00 Pas;
Kavya 62 200 31.00 Fail

MS-Access _

MS-Access makes use of tables and records to store information. It is a cdatabase
management system from microsoft. It can also important data stored in other applications
and databases. Now, let us learn how MS-Access 2007 application can be used.

STARTING MS-ACCESS 2007

The various steps to start MS-Access are:

®  Click on the Start prompt of Windows desktop and select All Programs.

121 ] |
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trom this menu
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-ascading menu appears trom where vou can select Mircosoft Office opuon

A
Another cascading menu appears

|

Now. select Microsoft Office \ccess 2007
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-
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Starting MS-Access 2007

The opening screen of MS-Access is ‘

called Microsoft Access Interface.

The main area of the Microsoft

Access Interface 1s divided into the

following three sections:

® The left side displays a column
head Template with various links
n it.

®  The middle section has two parts.
['he top section is used to create a
database. The bottom section
displays some promotional
information from Microsoft.

¢  The right side displays a column
titled Open Recent Database with
a More button under it. By
detault, the area under the More
button is empty.

i 42 I
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You can also start MS-Access by clicking on
shortcut icon on the desktop. if it is available.
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; : - will see a new dialog carca B ———
box on the right side of the opening screen window,

File Rame-
where you need to type the fijle name and click on  pembese: -
the Create button as shown along side. i
You will see the Database Interface Window of =
MS-Access titled Databagse | : Database (Access o Cami

2007) — Microsoft displayed on top of the window as shown.

) L ar N " -
Mg;f?s:ﬂ —d n [_-_I > ] Datatase] : Datatie decris 2067 - W Tate e e

e _ ] " Access
O ' 1 . - = E RIbeﬂ

Ll =ik ~ T

— /|| 2 Tables o el x
Quick |~ Tatkiied : L e

Access 7 — Gaba Tabe %

Toolbar

— V@brkspate —

Access |
Navigation —————
Pane

| ) imcnr W iet1 " Leeit
Datasheet View

- - -

- —— R —————— —— S J

PARTS OF MS-ACCESS DATABASE INTERFACE WINDOW
The Database Interface Window of MS-Access 2007 consists of the following parts:

1. Access Ribbon : It consists of a row of tabs such as Home, Create, External Data and
Database Tools. When you click on each tab, it opens with its own individual Ribbon and
particular icon. Each tab on a Ribbon has a group of icons that perform similar tasks.

2. Microsoft Office Button : It is located at the top left corner of the Access screen. It is
used to perform functions like Opening a file, Creating a new file, Printing a file, etc.

3. Quick Access Toolbar : It is located on the right side of Office button and is used to
provide quick access to some of the common commands such as Save, Undo and Redo.
You can also customise this toolbar to add additional commands.

4. Access Navigation Pane : It is located on the left side of the Access screen, Access
database has four main components (called database objects) — Tables, Forms. Queries
and Reports. Their icons can be seen at this'navigation pane. Whe_n you enter the data in
the workspace, you will find these options in the Access Nawgatfon Pane. To open one
of your database objects, you just ha\_fe to click on one of these icons and the required
object will open in the main Access window. —

43 |
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K Workspace © [ s the place wnere you actually “ M"‘d Fc.r.-c"

cresls 2 tanie and carry out other database lasks. av

An MS-Access database has :

accdb extension.
COMPOMENTS OF MS-ACCESS DATABASE

An WS- A database has the following components (or objects)
1. Tables : Tzhles are the dawzhase files logically organised in the form of rows and
elumns 1n a relational database werminology. a row of a table 15 called Tuple (Record)

and the wolumn s called Attribute (Field) We enter the data in table:»

2. Queries : (e, are asically guestions based on the data of a database. They allow you to
extra data o nformanon bow the fields, records and summarnies of the table or database.

3. Forms : Forms are the mnput screens dﬁlgred to simplify the data entry process. A
cormpuler user generally prefers wo enter data in a 'J.'E:]I-desigr,-ed form. rather than a table.

4. Reports : Pepors are the layours designed for viewing or printng the data of a
database By using repons. you can view the records of a wable 1n a well-designed layout

- Figer v f T Fpes F P e fee Y
a% J/‘- S .‘/ ITCTNCTIL

5. Modules : Modules zre the collection of programs written to access the database.

6. Pages : Pages are used 10 add. view and edit data of the tables.

7. Macros : Mazcros zre the sets of mstructions that help you to calculate your repetitive
tasks performed on a database

) G- Closing MS-Access Database . S

| To close MS-Access dawabase, click on the lQ- g X = ™
.'\r‘licrrm:lt Office Button znd sciect ‘Close
Databaw option from the menu. We can use the o

- - FF g L tmames
- - . + b o ST g
Fxit Access option from same menu for exiung - Py S
from ':f’;-.-".’.'.":'-'. e - R0
Access vs. Excel Bl s
fheress databases znd tice spresdsheets have
- - : -
sirmilar functions. “owever, Excel is not 3 database
1 g B )
management applicztion. Excel spreadsheets store 3 e
a1 - = mns c2iled -
data in rows and columns 3l woresheets. The S

most comman use of spreadsheets is to perform
calculations. On the other nand, '/:-Ao:ess stores . R
datz in 1ables tho ook similar 1o worksheets but | 3 e cemese
function auite differently. Access allows the user to
" combine dz1z from mutiphe tables, analyse and/or
report information in 3 nurmper of different ways.

2] kczess Optems X Iyt sotens
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~ Look at "h"-: Picture shown below and label the different parts of MS-Access Database |
' Interface window. .

- =3 - 1
- ot
el Pygie T - . rmtw
I O el i
$e  EemalData  Databes Yook  Acobal Datainee! ol
ey | » - -

o gy T “a Type N =
v a9 Eviting | ok .

e Faricta - q= ] '

) Al Tables | . =
Tabiel

T

vl
o
]
i

Add New Feld
T
::l ablel Table = {Ne_w}__
S
| >
< -
L Retorg M 1ott o Saarch j
| Datashes! vaew
— e = R Nem Lok 30
A T s e o g v — = =—— e 4

% "R
— _
A. Tick (v') the right option.
1. An application software which is used to create and maintain a database
(a) DBBS | (b) DBMS __ (c) DDMS . (dDPMS
Z. MS-Accessisa:
(a) Word Processor —— (b) Spreadsheet e
(c) Database . (d) Worksheet
3. A database ..o data redundancy. c
(a) increases L] (b) reduces L
(c) does not effect ___ (d) none of these :_J
4. The main area of the MS-Access Interface is divided into ................ sections. |
(a) two __ (b) three . (c) five . (d) four .
N — consists of a row of Ribbon tabs with headings such as Home, Create,

External Data and Database Tools.
(a) Access Ribbon
(c) Quick Access Toolbar

(b) Microsoft Office Button L

| S

(d) Workspace |

LIL]
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Fill in the blanks with the correct word.

- A

accdb  workspace database Microsoft Office Relational Database Management

I1s a system for collecting and organising data.
“. RDBMS stands for ... System,

i

wonns DULON S located at the top left corner of the Access screen.
= An MS-Access database hasa ...

=
wd

e @XEENSION.

, ~w 15 the place where you can actually create a table in database interface
window.

State whether the following statements are true or false.
L. MS-Access is a Database Management System.

-« A database locates information with the help of a simple query. | __
A database does not support communication,

=

—
*+ Quick Access Toolbar is located on the right side of Office button. B
- A column name is also called a field name.

2. Tables, queries, reports and forms can be created in MS Access. -
Answer the following questions.

! ~- What is a database? Give examples of a database.
“. Write any four advantages of a database.
What are the database objects ? Name any four.

- What are the various parts of MS-Access Database Interface window?

How is MS-Access different from MS-Excel?

#  Make a table of your friend’s addresses and phone numbers with 10 records and 5 fields
__(Name, Address, City, Mobile No. and E-mail ID)
>

h W | - E—— "

©®  Start MS-Access and write in your practical notebook about the various steps you will

follow to open it.

© Open the MS-Access Database Interface window and make a chart showing its various
parts in your practical notebook.
.1
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Creating a Database and Tables
Basic Structure of a Table
Opening a Database and Tables

«  Modifying the Table Structure

+ Inserting and Deleting Records
» Editing Records in Tables
- Sorting Data within a Table

In the prcx'iousi chapter, you have discussed the basic concept of a database and the various
components of an MS-Access database. A table is the basic component of a database in

which you enter data. In this chapter, you will learn to work with the tables.
CREATING A DATABASE AND TABLES

There are basically two ways to create a database and tables in MS-Access:
I. Using local or online templates

2. Working with a blank database

Although using templates is the fastest technique to work on a database, it is however, not
recommended for beginners who want to learn the database. Therefore, we will first learn to
create a database by working on a blank database.

Let’s follow the steps given below to create a database:
Start MS-Access by clicking on Start button and selecting Microsoft Office Access
2007 option. The opening screen of MS-Access called Microsoft Access Interface will
open before you.
Click on the Blank Database icon at the top of Microsoft Access Interface. You will see
a new dialog box at the right side of the opening screen window.
Type the name of the database (say Student) and click on the Create button.

Now. MS-Access Database Interface window will appear on the screen, where you can
create a table.

CREATING A TABLE IN MS-ACCESS 2007

There are mainly two ways to create a table:

I. Using Datasheet View : This view allows you to create a tgble in the spreadsheet view
that you commonly use in MS-Excel. Data can be eflte'red directly into the table in rows
and columns. Although, this is a simpler method, it is not a professional approach of
working with tables in a database. |

2. Using Design View : This view allows you to create a table in a Professional way by
first defining the structure of a table and then entering the data. This method is used by

programmers and professionals.

| 47 i
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tables using both views.
ating a Table by Using Datasheet View
M detaalt. a table 1s created in Datasheet View. When vou create a database, the workspag.

of a Database Interface window shows a table with default name "Table 1" in the Datashee:
View. Just start entening the data in rows and columns of the table

(without entering
headings) as illustrated below.
Ina

datasheet the field names by default are seen as ID Field 1. rield 2, Field 3, ete. where
ID 1s used for identification number generated automatically as 1.2.3.... and so on. However.
You can also rename the fields later on. After entering the d
either by pressing Ctrl + S Keys tog i
Type the name of the table (say M

ai.. you should save the table
ether or choosing Save option from the Office button.
arks) in Save As box and press OK button,

L ™
Save As L) Skl
. — .
T S o vw
§ - .,
" R Qe
- S
i e
i___' oy ‘U a8 b |
g For Your In@o Creating Table in Datasheet View

To change the name of a field. place the cursor anywhere on the column and click on

» Rename button of the Fields & Columns group of Datasheet tab and type the new name of
~ the field.

Creating a Table Using Design View

The Design View allows you to enter names of the fields in the table and specify their data
types. A data type indicates the kind of data (for example, numbers, text, or dates) to be
stored. Let’s create another table in the database, ‘Student’, using Design View by following
the steps given below: _— M
: 4 Cg) ™ ¢ Dotuivee’ Dot Acoem J0N - M. g weo

®  Select Table Design option from the Tables | *
group on Create tab as shown along side. Focine

@ You will see the Table Design screen with | | W g
three columns — Field Name, Data Type and | .. .. s R
Description. Enter the field name, data type t g - o i o [—
and description in each field of the table as | :
shown.

‘—4-8-. Creating Table in Design View
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® Save the table either b

Defined Fields in Table

y pressing Ctrl + S keys together or choosing Save option from

the Office button. Type the name of the table (say Address) in Save As box and press

OK button.

® A message box
appears on the
screen giving you
a warning that no
primary key is
defined. Click on
No option.

®  Press Ctrl + W keys together to close the

table window.

Microsoht OMice Access — -.;
i

There is 80 primary key defined. l

f I

§ . Mmougn o premacy Ley s requres, ' hignly recommandad. A tabip must b 8 primary by o1 1o o et 8 Ieigtonghip betv.gen g tubly pod per |
ISR tmble in the detabese |
Do you w10 Owets 8 primpry Ly now? '

| ves ) g Cancel {

)

Dialog Box Prompting for Making Primary Key

f For Your I"go

"B A primary key is a field that contains
s unique values such as Roll No, ID, etc.

BASIC STRUCTURE OF A TABLE e T A
Various elements of a database table are Field Name, Data Types, Description and Properties.

Let’s discuss them.

1. Field Name : Field name can be of maximum 64 characters, that also includes spaces.
However, it should be smaller and meaningful.
2. Data Types : A field can be in the form of numeric, character, date, etc. as listed below:

(a) AutoNumber :

An AutoNumber field creates unique values automatically on

creation of a new record. It is mainly used as a [?rimary key.

(b) Text : A text field contains values that are in the form of text, numeric or a
combination of both with a maximum length of 255 chara'cters,

(¢) Memo : It is a much larger version o_f a text field, allowing storage of up to 2 GB
data. It also supports rich text formatting. mobaly

49
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() Number : The Number field can store numeri vilues up to 16 bytes of data

(¢)  Date/Time @ The Date/Time field i wsed to store date and time data

() Currency @ 'The Currency datia type stores values 1 a monetary format, which ¢,
he wsed for fimancial data

() Yes/No : Lopical data s used when only one ol the two options 15 valid — Yes/N
or True False

(h) OLL Objeet @ The OLE Object field stores nmages, documents, graphs, cte. from
other Windows based programs.

(i)  Myperlink : The Hyperlink ficld type is used to store Web addresses.

(j)  Attachment : The Attachment ficld type is used to store images, spreadsheet files,
documents, charts and other types of supported files as an attachment for database.

3. Deseription s The name of a ficld may or may not be meaningful. Description describes
the name of a field so that you can understand its purposc.

4. Properties : Lvery ficld in a table has its propertics to define its characteristics and
behaviour. You can specifly the propertics of various ficlds of your table in the Field
Propertics pane of the Table design screen. Various options available under the Field
Propertics pane are listed in the table below.

Field Property m, S et _ s

Iield Size [t sets the maximum size for data stored in a field to accommodate
text (0-255), numbers or auto number data type.

Formal [t customises the way numbers, dates, time and text are displayed and
printed.

Input Mask It makes data entry easier and controls the values which a user can
enter into it.

Decimal Places It specifies the number of decimal places for numeric data.

Caption It provides helpful information to the users through captions on
objecls in various ViIews.

Default Value When a new record is created, it allows the default values to be
entered automatically.

Validation Rule It enables you to limit the values that can be entered in a field.

Validation Text [t enables you to specify the error message that is displayed when the
validation rule is not passed.

Required It forces you to enter a value if Required property is set for Yes.

Allow Zero Length It accepts a blank entry if Required property is set for Yes.

Indexed It speeds up sorting but may slow down the database.

Smart Tags [Lis used to add tags like date, telephone number, financial symbol of

person name in the field. Each tags is associated with an action or?
list of actions.

£
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/& Rich Text Mgmo field anows better format
* Datasheet View, you can apply formattine
. the Rich Text Memo fielq ’

1&,&_%

ting of data in tables, forms and reports. In
features such as bold, italics and bulleted lists to

OPENING A DATABASE AND TABLES

You can open an existing databage and tables by following the steps given below:
Start MS-Access by clicking on ([ =
Start  button  and  selectipg | €

Microsoft Office Access 2007 —
option. '

|
Bt v

Click on the More button Jocateq | H - Gy : o
on the right side of Microsoft I W = .+ | . =
Access Interface. You wil] S€e an | so o L | e’ Smeen s

Open dialog box.

Select the required database fije “ | R .
from the box and type the name o ol . oot e
of the file. Click on Open button | . -

to open the MS-Access Database | | *=
[nterface window. &

MS-Access Database Interface ——— _

window will appear on the screen.

To open the required table, double-click on the table name from the Navigation pane.
The table will be opened in a Datasheet View

? For Your 1"6’0 |

“§ You can change the view of a table Dy selecting the required view (such as Datasheet or
+ Design View) by clicking on the down-arrow key of View button in Views group on Home tab.

______________________ A
MODIFYING THE TABLE STRUCTURE

Sometimes, you may need to modify the structure of your table. You can insert new fields

and delete any field. You can also change the name, data type and other parameters of the
field.

Let’s first learn to insert a new field.

Ir serting Fields

To insert a new field in the table ‘Address’ of database ‘Student’, follow the steps given
below:

®

Open the database ‘Student’ and table ‘Address’ as explained earlier.

By default, the table opens in the Datasheet View. You can insert field in both Datasheet
and Desig;l Views. To insert a new field in Datasheet View, place the cursor anywhere
on the column where you want to place the field.

: ‘ Computor Scionce ' ls_l}
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Click on the Insert button of Fields
& Columns group located on the
Datasheet tab as given.

A new field with the name Field 1° .
will be inserted at the curent @ — -
column position. Now, click on the
Rename button of Fields & Columns | -

group of Datasheet tab to give a new

. ar Unir q"'
name to this field. Type the name as ‘}' Fo 9"1‘__22}“6"“ .

Gender and change its formatting features
(if required) by using the various options
of Data Type & Formatting group.

Save th

“f You can also insert a new field in Design

View by clicking on I[nsert Rows buttor

of Tools group on the Design tab.
¢ table and database as explained earlier. _

~ 8 "
T 10
weieling rie

g rioies | # Mind Feedar
Deleting a field means deleting the entire data of ' |

that column from all the records. So. youshouldbe  Delete a field only if it is empty or
very careful while deleting a field. Follow the steps not required by you.
given below to delete a field:

Open the database *Student’ and table *Address’ as explained earlier.

The table is opened in the Datasheet View. You can delete a field from both Datashee
and Design Views. To delete a new field from the Datasheet View. place the cursor
anywhere on the column which you want to delete.

Click on the Delete button of Field & Columns group on the Datasheet tab.
The selected field will be deleted. Now, save the table and database as explained earlier,

LE |

_ ' 9 For Your Ingo

You can also delete a field from
e _ «| " Design View by clicking on
- 1 Delete Rows button of Tools

Selected column i group on the DESigﬂ tab.

INSERTING AND DELETING RECORDS

In a database, inserting a record means adding a new record. It does not mean inserting @
new record between two records. In fact, we cannot insert a record between records in 2

table. We can only add records at the end of a table. Deleting a record means deleting dats
from all the fields of a record.

Inserting Records
Let’s insert a few records in ‘Address’ table of ‘Student’ database by following the steps
given below:

Open the database ‘Student’ and table ‘Address’ as explained earlier.

The table will open in the Datasheet View. You can enter your data in the records &
illustrated below:
fro-1
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e LW You canalso insert records by
: v Clicking  on New  button ol
Records group on the Home tah.

Aller entering, the recorls, Press the Keys Crl o+ W topether to save and close the table
Save the database gy explamed carlyer. II

peleting Records

you can delete a record by lollowing (he sie
Open the database *Student® and
table *Address’ as explamned carlier

ps given below

[he table will open i Datasheet

View. Select the record whichy you - —
want to delete by clicking on the | ————
box placed on the lefi side of the Suad

same row in the Workspace. :
Chick on the Delete button of Records group on the THome tab. A dialog box asking vou
to confirm the deletion process will display on the screen. Click on the Yes button i you
want to delete the selected record.
Save the table and databasc as explained carlier,

EDITING RECORDS IN TABLES

After entering data, sometimes it is required to make changes in the database. This can be

done in various ways.

*Toedita record directly, scroll through the records or use the Navigation buttons to tind
the record to edit.

* Chick the cell where you want to make changes. A pencil icon appears to mdicate Fdit
mode. —

*  Type the information into the field.

v Click outside the record/row to apply the
change.

SORTING DATA WITHIN A TABLE

We can sort data within a table with respect to

d particular field either i ascending or

descending order:

LA LRLLALRA

Select the desired field.
Click the drop-down arrow at the top ol

the field you wish to sort. Sorting Data

=
‘ Computer Sclence F
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When the menu appears select either Sort A to Z or Sort Z to A option and observe gy,
change in the database.

\2 = LEEO m Ctrl +S

The Sort commands in Sort & Filter ~ © Save the table

group on the Ribbon is another way to @ Close the table Ctrl + W
. sort the data. To clear your sort, click & Create a new database (trl + N
. the Clear All Sorts command in the

' Sort & Filter group on the Ribbon. SROPEHaGatabase Ctrl + O
e e B e i g A

[ — — —

() Circle any ten terms related with databases in the following grid.

icle|[T[a]B]L]E][s|z]A

Alp[A[TIE[T|u[B[A[U

plclk[Lv[rR|w/x|Y|T

‘t{clulR R'L_é_'_N"c“iY 0

:_'_l____'F____EI!J plafI] HICIN |
| O[E|GIO|E/VIFILIF]U, |

IN/M|DINIFITIG|T|!|M] |

Nju[m[BE R[H|EE B

M ElMo|L € a/x L E |

R €e[clolr[o[r[T D[R] |
' =) _. il -

r §efrain 4

B e e e - — — e U

A. Tick (V') the right option.
1. Aview that allows us to create a table in a spreadsheet view:

(a) Design View ] (b) Excel View []

(c) Datasheet View [ ] (d)None of these ]
2. A........keyisafield that contains unique values.

(a) Main L (b)Primary -

(c) Secondary L (d)]Junior b
3. Afield that allows better formatting of data in tables, forms and reports: B

(a) Memo || (b) Text L

(c) Rich Text Memo [ ] (d) None of these [

f— Computer Sclence .

Book+7



—

A PrOpErty ciables s vo i the values that can be entered in a field.

() Validhatioon T L, (h)Validation Rule =
(c) Allow Zevo Lenptly [ (d)Noneofthese Lo
vitlin the blandes with the correct words,
AutoNmbey hyperlinle 64 Memo Data Type
I Aieldame cannor have more thay ... Characters.
2. Mn Vemaily waed as i primary key,
I, el Buger version of a text field, allowing storage up to 2 GB data.
4. The held type s used 1o store web addresses,
o atype of freld tha specifies the type of data you can enter into it.
State whether the following statements are true or false.
Lo Aleld name comot include spaces, |
2, Wecandeleteafield m Desipn View, L__
1. Deleting a hield means deleting the entire data of that column from the
selected records only, |
4. We canoinsert records by clicking on Insert button of Records group on the
Home tah. |
5. When a new record is created, it allows the default values to be entered o
automatically. L_
Match the Columns.
Column | Column 1
1. Number (a) creates unique values automatically.
2. Text (b) can store numeric data only.
3. AutoNumber (¢) storesvalues in a monetary formats.
4. Yes/No (d) can contain values that are text, numbers or both.,
5. Currency (¢) logical data used when only one of two options is valid.

Answer the following questions.
1. What are data types? Name all possible data types that can be used in MS Access 20077

2. Write the steps for inserting and deleting fields in a table.

3. Explain the following properties:
(a) Field Size (b) Default Value  (c) Caption (d) Allow Zero Length

| 55 |
Computer Science
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Give the difference between

(a) Datasheet View and Design View

(b)) Number and AutoNumber data type

Create a database and required tables for school Ex

structures in your activity notebook.

Collect data of any one apphcation (such as accounts, marke
and magazines and organise that into a d

your computer teacher.

4
{{ . ’] ll/li MVII I"
\" - ..

amination System. Write their

ting, etc.) trom newspapers
atabase and required tables with the help of

Create a database with
following structures:

your school name and two tables ‘Exams’ and ‘Fees’ with the

Exam Table
Term lext Term of Exam
Ex-Date Date Date of exam
Class Number
Section Text
Roll No. Number
Subject Text Subject Name
Marks Obtained Number Marks Obtained
Maximum Marks Number Maximum Marks

Fees Table

Reg No. Number Student Registration No.
Name Text Name of Student
Admission Date Date Date of Admission
Photo Attachment Student’s Photo
Month Number Month of Fees
Year Number Year of Fees
Payment Date Date Fee-Pay Date
Amount Number

Fees Paid

Enter any 10 records in both tables and save the tables.

& “":::u l;hm ;
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open the database and taple
tasks:
3 "W Po. . - > 2
for the new field.

: for iollowing
s created in the previous question and perform the followiny

(b) Insert 10 more records in both the tables
(© Delete any 5 records from both the t

MS OFFICE 2010 UPDATES
MS-Access 2010

ables, which you do not require.

| ltallows the users to share a database on (he web. A database is created using .t ceess

2010 and published through Access Services in the Microsoft SharcPoint 2010 scrver.

This allows other users, who do not have Access 2010 on their system, to view the data.

2 It provides enhanced levels of seeurity to the user’s data. This has been made possible
with the help of Microsoft SharePoint Foundation 2010. This cnsurcs recovery of
deleted files, setting access permissions and audit revision history.

Taa

~ Ithas a new tunctionality Sereenshot which allows the user to take a snapshot of any
active document.

. Smart Tags allow additional information to be added to a database which otherwise
would require the support of the web. It is in the Design View of the report, from or data
access page. It can also be used to schedule meetings, add contacts of instant messaging.

etc. !

L]
g On Teacher's Desk
G 1. Use the Internet to learn more about how MS-Access 2007 is used in the corporate
i

world.

2. Prepare a class list of students in alphabetical order and give them their attendance
record of last three months. Given each student a copy of it and ask them to prepare a
table in MS-Access 2007 based on it. Also, ask the students to generate a report.

| =
-. ’ I 57 |
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% Lesson Extract L

\
o Slide Show Options < Spell Check

« SetUp Slide Show + Running a Slide Show

« Record Nanation + Printing a Presentation

< Rehearse Timings *+ Tips for an Effective Presentation

+ Create Speaker Notes

In the previous class you have learnt about some of the features of PowerPoint. Now. you |

will learn how to set up/view a slide show and print a presentation.

A slide show is an on-sereen
show enforces the ideas. com
special effects to a present

SLIDE SHOW OPTIONS

presentation of information/ideas presented on slides. A slide
ments, solutions or suggestions presented in the slide. Adding
ation increases its impact on the audience.

The Slide Show tab on the Ribbon cont

ains many options for the slide show on the Star
Slide Show group. These options include

@ Starting the slide show from the beginning.
@ Starting the slide show from the current slide,
@ The third option is to create or play a custom slide show.

A custom slide show displays only the slides you select. It enables you to have

several
different shows within the same presentation.

o o -

4 Home Insert Design Animatons Shde Show Review View L7
R . | i ] J "D Record Narravion ul| Resolution. Use Current Resolution *

-t o} —gpad ] -

L o 3 = ¥ 57 Rehearse Timings

From From Custom Set U'p Hache -

Begnrng Currerd Shde  Shide Show *  Shde Show  Shide V' Use Rehearsed Timings Use Presenter View
b SPow o

SET UP SLIDE SHOW

This option allows you to set preferences on how the slide show will be presented. When
you click on this option, a Set Up Slide Show window appears on the screen. It presents

many alternatives for the slide shows. It has many options like Show type, Show slides.
Show options, Advance slides, etc. Let's know the functions of these options.

58
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with the options on the Set Up Slide Show dj

show type @ This opyj " . .
I S . ) ption wy]| confipure . . ; A , tvpe. It gives
OpLioNs 10 present the shouw o gure the presentation slide show type. g

presented by a Speaker (Fy)p @ H0

alog box you can do the following :

Screen)  or bmwscd by an M vy 2 v - '
A1 P I3 v L L TR e
Individual (Window). o i
3. Show options : Thijg option wil] -
run the slide show unti] YOu press ' oy Ve -
ksc. & i Jriueieieimoniii i SRR
You can present the slide show S
with or without a narration o
animation in it.
3. Select pen color : This option is
used to select the color of the pen
in presentation. This pen may be

used to white something on the __r—" §
compuler screen at the duration 0 e - L2 ¥ b Aot
of presentation. Using Set Up Show Dialog Box

4. Show slides : This option is used to select the number of slides for the slide show. You
can select All to include all slides or choose a few selected slides.

Advance slides : You can choose to change the slides manually by pressing Enter or
clicking on the slide. To set the show to proceed automatically, select the other option of
Using timings, if present.

6. Multiple monitors : This option is used to select the monitor from the drop-down list in
the Multiple monitors area.

7. Performance : This option is used to enable or disable graphics acceleration features.
Check the Use hardware graphics acceleration option under Performance section unless
your presentation isn’t working | La-0 -

n

properly. 3 el 7 3 e ;
RECORD NARRATION ’
MS-PowerPoint allows you to J @) | §
record a narration for the slide ! l a3n' .
show. As you record narration, it R || [ Recend Namton  ——
stores slide files separately so that I P i | 5, N 20 |
the slides are synchronized with E‘?F:‘Lﬁl éﬁ&.u sl
the Narrations you recorded. You | (= ot
need to connect a recording device I “j- Adasl sty Gottni Lo s hieve ested sounsd ity snel disk wiage e
0 your system and make sure that N e ;
the microphone  software is P D, ) o [ E
stalled in jt. — .
The various steps 1o record sds 001 DM ey 3o : _ ‘u‘."-a A s -
nal‘ra[ion for the slides are : Using Record Narration Dialog Box I‘S‘?‘\

ﬂllllll!“lllcl
Book-7
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“  Go to the Record Narration option from the Set Up‘ group of the Slide Show tah |
click on it. A Record Narration dialog box appears. It informs you how much hard dry
space you have and calculates the maximum length of the narration that you can recorg

Set Microphone Level to check the level of audio input.
% Click OK to record the narration.
REHEARSE TIMINGS

While creating the PowerPoint presentation, it will be difficult to choose the right timing to

give the presentation a natural flow. MS-PowerPoint 2007 has the features to rehearse
timings of the slides with audio.

The various steps to rehearse timings in MS-PowerPoint are
@ Click on the Rehearse Timings option from the Set Up

Y
r

group of the Slide Show tab. This will begin the ”‘
PowerPoint presentation but in the rehearsal dialog box. ] | S

; . " i . . Bas — & Renearse Tumings

®  Practise speaking and advance the slides as required in sevp be
the presentation. de Snow  Shde

®  Choose whether or 16t to keep this timing or try it again.

CREATE SPEAKER NOTES

Speaker notes or Notes Pages are notes added to the presentation slides as a reference for the
presenter. They allow you to create for each slide.

The various steps to add speaker notes are :

®  Select the slide.

# Go to View tab of MS-PowerPoint window and select Notes Page option from the

Presentation Views group. Click to add text section appears below the slide.
% Type in the notes for that slide.

-
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i (ext allows you o check your entire proesentation for spellinge crees Py et 1in
4 ¥

L [ ¢
hpcky Hhs Ll i

I
tIl'lt‘“u'ol'lill'l\‘ \\Illt’h YO can Cusltonnze with wandlns 0l JUi ¢ Jpigne e s
[hm”,_.Jmut apresentation

» o 1O [|l|_- I{(wh-\'\' I1I|l nllll tllt | ane i g’l“"“"l! borgtbagrs 10 Phie l'puuflnp{ YEENIY

spelling check boxappeirs Cliange the spelling o genore Wie sujjee sled ot

/

Using Spelling Button in the troafing ot of esie s Tl
RUNNING A SLIDE SHOW

You can run your presentation i the lulluw.“,. Wity
To start the Shde Show, chick on the Slide Show bution of the Presentation Views
group on the View tab

¢ Usce the arrow keys at the bottom of the screen Ly Ouick Key)

to move torward or backward i i presentation slid fe
3 . Run a e show J
Press the Escape (lose) key to end the shde show

PRINTING A PRESENTATION

[here are many options aviatlable for prmtimg o PowerPomt presentation Fhe

¢ Slides @ Shides are hke the pages ol the presentation mlmﬁ'}

* Handouts : This option allows you to have more shdes, 'Prlnt Ctrl + P
In a page
Notes Page @ Thas includes the shdes and the speaker notes

Outline View : This will print the outhine ol the presentation

[he various steps to take a primtout are - -

“ Chick on the Microsoft Office Button A e P
drop-down menu appears T oo

* Click on Print option A prnt dialog box —- "
appears on the screen e ;

* In the Print dialog box, chick on the arrow

next to Print rangce, " s 4
Print rangc P o h}}ﬂ_.,yj

*  Choose the other oplions as required and

click OK to print. Before taking the o oy

pl'inlmlt you can sec 1s preview, |, ——— . ﬂi
® To exit print preview, click on the Close l' - 10 i -

¥ wwapy
o La (L e

Print Preview button, [

L [FEEPT

Llsineg Print Dialog Box gy
|61 j
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TIPS FOR AN EFFECTIVE PRESENTATION

While designing and running a presentation, the following points should be kept in ming -

Shides should be of a consistent design throughout the presentation.
Use graphics and pictures to make the presentation attractive,
Remove unnecessary information and graphics.

Use contrasting background and text colours,

Use maximum three fonts for the text in a presentation.

Keep the fonts consistent throughout the presentation.

Identify the critical information for your presentation.

Use not more than 6 bullets per page.

Text under buttets should be short ideas, not complete sentences.

Be sure 10 preview the slide show using a projector if it is required during a
presentation. Words or graphics that are close to the edge of the screen may be cut off
by the projector.

i
o~

-

& | [4, £ € .

5 B -_.!’OOSt h,;pur "E‘-i::} rain
o— : s —

a k e 2

A.  Tick (V) the right option.

R

Slide Show option is there in the NN . | )
(a) View __| (b)Home L
(c) Insert | (d) None of these L]
Which is not correct about an effective slide show?
(a) Use graphics . (b) Use complete sentences -
(c) Use consistent design for all slides . (d)None of these
Notes Page is for
(a) speaker notes [ | (b) handouts ]
(c) slide show [ ] (d) None of the above []
. Which option(s) can be used to get the printout of a PowerPoint?
(a) Slide L (b) Handout
A (c) Both of these i (d) None of these L
5. Which is the short-cut command to print a slide?
(a) Ctrl+Alt+P [ ] (b)Ctrl+p L]
(c) Ctrl+Print 1 (d) None of these L]
| a—



fill in the blanks.

Close Pr View i
Int Preview  Record Narration Slide Show Review

Escape Proofing Escape View

'Ii“ e T;huw cliek i, button on the Presentation Views group on
the tab

button is used to end the Slide Show
: button is used to record narr

ation for the shdes.
b Toexat print preview, click on the

o button.

-~

5 To check the spelling throughout
woogroup on the
. Match the following,

Columns A

a4 presentation, click on the spelling button in the
i TR

Columns B
1. Show type (a) Select number of slides
2. Show options (b) Full screen/Window view
i Show slides (¢) With or without a narration or animation
L. Advance shdes (d) Graphics acceleration
5. Performance (e) Manual or automatic change of slides

D. Answer the following questions.

I.- Whatare the various slide show options?

1. Tlustrate the steps to print the presentation.

5. List out some important things to keep in mind for an etfective presentation.

notes pages and outline view? Give your reasons.

&)
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Create a PowerPoint presentation of ten slides on festivals of India and take the printouygg
of the slides and paste them in your Social Science Project file.

—

Create a PowerPoint presentation about the following quotes on Friendship as

sliown below.

Slide 1 : Friendship

Slide 2 : Happiness is like perfume, you can'’t pour on others without getting a few drops
on yourself.

Slide 3 : Friendship and love has its own time, season and own reasons! You can't ask it
to stay, you can only embrace it as it comes and be glad that for a moment iy
your life it was your!

Slide 4 : True friendship doesn’t have a happy an ending.

That’s because true friendship doesn’t have an ending.

Slide 5: As long as we have memories, yesterday remains, as long as we have hope,
tomorrow awaits. As long as we have friendship, each day is never a waste.

Slide 6 : Friends are like stars. You can't always see them, but you know they are there
Have great-hope and dare to go all out for them. Have great dreams and dare to
live them. Have tremendous expectations and believe in them.

Slide 7 :

The recipe of friendship : 1 cup of sharing, 2 cups of caring, 1 cup of forgiveness
and hugs of tenderness. Mix all these together.. to make friends forever.

Computer 8clence .



MS-Excel 2007

T{ Lesson Extract I

» Starting MS-Excel “ Delefing Rows/Columns ~ + Adding a Clip Art
. Ccomponents of M3-Excel “* Find and Replace < Adding Shapes

. formatting Cells * Go To Command % Adding a SmartArt
» Inserting Rows and Columns Adding a Picture

Exiting Microsoft Excel

_’______._-—-'—— i — e e e — ._-.—.,j

\S-Excel is an application software in which calculations are done after you have entered f\.
data into the grid of rectangular cells called Worksheet. In your previous class, you have ‘ }
learnt how to work with a workbook and worksheets in MS-Excel. In this chapter, you will
learn some features of MS-Excel on formatting to make the worksheets and their data
visually appealing, organised and attractive. Before discussing these features, let’s

understand the components of MS-Excel Windows alongwith the way to start MS-Excel.
STARTING MS-EXCEL

MS-Excel is a spreadsheet program that comes with the Microsoft Office package.

The various steps to start MS-Excel are: - 3
®  Click on the Start button. fiad coemans ' ﬂg,,
I’V Covgl Vet a 10 » I '\:-:.nwﬂ&}ﬂ"te o)
®  Select All Programs. P N cre O e 285
. -l,.,.,,,,-....., | l.'-mnﬂﬁ"m?w.‘x-‘
¢ Go to Microsoft Office. )i | veomnonas et
®  Click on Microsoft Office Excel 2007 to |m ... '

Opeﬂ it. _ Coltwiato | l‘— '»'r:'_::!cfl Oftce :«::: \:: l:i‘“
AnMS-Excel 2007 window opens before you. owiut
COMPONENTS OF MS-EXCEL ' 3 e (e

cenmnns (2
AnMS-Excel file has the following components: | ..« .. | o .
Workbook : An MS-Excel document is called a [* **=
workbook. A workbook contains many sheets to | ! . ‘

Work on, It may open any number of sheets till it 50—

fi : ;
nds memory available for it. Using Start Menu to Start MS-Excel
Worksheet : Just as a book has a number of

pﬁges’ an MS-Excel workbook has a number of g ) For Jour I"'go
. :
s called worksheets. A worksheet is also To create a shortcut of MS-Excel,

OWn as a spreadsheet. v select the MS-Excel option from the
| start menu and drag it to the desktop.

L
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names of worksheets in a workbook are sheet!l sl | i
! l I!l- ' ::‘-\‘l :‘. T | et 1S il ald il
- -
: i
. -
- € a E R N 8
. .
: N
i L]
LA™
. Rl
R s ———. -
) An Opening Scren of MS | xcel
‘ f Il.’m' Ilitﬁ-

Ihe new MS el workbook contains thr

[

oworksheets by detaah

‘ *
\ocell s an itersection of g column and a row i ' " e la
worksheet: Fach cell s denoted with cell address. For . _
example, AS reters to the cell at the intersection ol column e - .
"Atand row S Dataois stored 1na cell A cell can contain up BV A L B R |
to 32,767 characters
ol & —— FORMATTING CELLS
tos - e pos We  can  use  different  formar
PR " = ‘ . 3 ) |L‘f1lll¥cw of MS-Fxcel to make the &
ot ol ’ of the worksheet presentable
W iln ‘ Fhe various steps to format cell are
L i _ ¥] ¢ i * Select the cells contaming the ds
o ®*  Chick on the arrow on the dis
sy ARRSCr Yy box launcher of the Font Erouf
o the Home tab. A Format (¢
L T " e o e dialog box appears on the scree
*  You can change vanous feas
like Font, Font style. Font size
. - Effects from the box and lick
!

INSERTING ROWS

I'he various steps to nsert a row in a worksheet are:

® Sclect the row above which a row is to be inserted
H
I 66 |
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o . S . %

whk on the [nse G0 | PP —— 1 o
’ nu " the ( clls group of the Home tab of the Ribbon A dnt
AT T P ar
(IR L L ot » % 24 o8
o - ‘ A new rowm gets insented above the selected row
- - : - ’ - » y
- ‘ a
. 2
T | > * . =
] - .: L] i N - » " ” 5 'F
- - e
- ‘

inwerting o Row 2
; For Uour Iﬂﬂ‘('

INSERTING COLUMNS 112 key 10 MS-Excel 2007 displays the

b
vanous steps o oansert a column in oa Y ohave Ay dialog bhox s‘
thshect ar

. woledt the column to the left of which a column has to be inserted

- )
. ¥ " L . . -
. 4
- > > L
‘4
e 'Rl | -
-
I w Tow .
" vt { gity
- - v ’ - -
v . L, S e mas . ‘8 L Rt et L gagiemny
L]
d 1.".k‘.l
f
2 3

inserting o (olumn ;
< i
¢ For Your [".6'
Chak on the Insert button trom

the Cells group of the Home tab Y0 lopen: & workbaok., click on ‘Open
! the Ribt A drop down menu - F option” on the (ffice button meny or
¢ Ribbon drog press Ctrl + O key combination —

appears 67
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Click on the Insert Sheet Columns option. A new column gets inserted 1o the left h
selected column. |
ELETING ROWS / COLUMNS
The various steps to delete a row ‘column from a worksheet are:
Select the row or column that has to be deleted.

Chek on the Delete button from the Cells group of the Home tab of the Ribbon. A

down menu appears. 2

e

Select the desired option. The selected row or column gets deleted.

- I| ¥ : I
A A "o ‘.". !
. . L4 EHo e @ ' ‘N Delote
" - A N ‘ r Delete Cell
Pt amap -\ e e |
X Delete Sheet Roy,
. i 4 5\ I
B ) ) i N - ) _- T . ‘ I Delete '_\hl et
Deleting a Row
2
3
. b3
Vo maws b & ;
L] ¥ Y | 3¢ I BN N ] 4 |
l Delat
]
- Sise . “ Delete Cell
1 ; s
1 1 7
] |l 4" Delete Sheet Column
Deleting a Column ~ Delete Sheet
FIND AND REPLACE

When you are working on a worksheet, you may need to search for a word or replace a wor
of the worksheet. The Find option on the Ribbon is used to locate a word in the worksheet
The Find option is combined with Replace command to replace a word from the worksheet
The various steps to Find and Replace a word are:

Click on the Find & Select button on the Editing group of the Home tab. A drop-doW’
menu appears.

Choose Find or Replace option. A Find and Replace box appears on the screen.
Type the word for Find what option. "
If you need to replace the word with a new word, type the new word in the Replace "
option.

ez 3

i 68 |
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Then, click on the Replace button.

you may search for more Options to replace the new word with.

LE R o l7‘1 - . T 2 } Fa) a l
T A — — —
v L Riglace

f&‘)’l:.f‘ Rey)) :a e | ,: <
. Find and Replace Ctrl + F e | ) ¥

. Replace e

Rep Ctrl + H S | [y )| o | =

The Go To command takes you to a s

pecific cell either by the
¢ type of document, you can navi

» ete. with the help of Go To co

cell name. Depending on th

cell reference (cell address) or
line number, footnote, table

gate to a specific page number,

‘ ‘ mmand.
The various steps for Go To command are:
n 'l " :::!! b = ;;' ’.' & S ‘ o - B 1
Rrtiand 3 -
const 2
Click on the Find & Select button on the Editing group of the Home tab. A drop-down
menu appears.

Select Go To option and click on it. A Go To box appears on the screen.

On giving the cell reference, in the Reference option and clicking OK in the Go To box,
the cursor selects the specific cell.

ADDING A PICTURE |
Ou can select a picture from your files in the computer and insert it in the worksheet.
The various steps to add a picture from a file are:

Click on the Picture option from the Illustrations group of the Insert tab. An Insert
Picture box appears.

Locate the picture from your files.

th Select the picture. The name of the picture will appear in the File name box.
\ Click Insert. The picture gets inserted in the worksheet.
| To move the picture, click and drag it anywhere on the worksheet. I_é_g-ﬂ
| Somputor Sclsacs =
y - ‘ Book-7 . i



. ; 7~
4 z —— y b L b Poums ) Sanpie Potor o ——"'{2'
| {omg Insen — \

- A
r. 3 T T !
. e O CLury
| PrctTab c ;
x Smana Borary
Ant B e " K10
| A Ol m\ . )
| 4 2o A
t - ! | Socwd Pasces Y
Al v ChAAATRs T (R e rge nigtna

| ; 5
|1 Ll ‘ n ok '
f — P T
| 4 a mr f 3./:| |\4\j
ADDING A CLIP ART 3
Clip Arts are the picture fife§:that can be o j —
inserted into a worksheet 5 “..x 3. opa 2 e | 1
The various steps to add a&Cﬁijfﬁn in a . bis Green " | e
worksheet are; il '*__i o -
3 . Al coliechons v
Place the selection box in the ' = HpIHII be
worksheet where you want to insert = = *l || Amean e =
the Clip Art. Now click on the Clip |\ [
Art in the Tllustration group of |! 1D
Insert tab. A Clip Art box at the | - ae | | ¥
right hand side of the window LR &
appears. Home et Pagelaout  Forra
Click in the Search for box and type R ..
the name of the picture. | e Semmannrenyy X - N
Then, click on the Go button, Many | siwes L .
Clip Arts appear. Click on a picture o X 2 ¢ B
to select it. 2 At -
L S \
The selected clip art gets inserted in | . “(‘? q
the worksheet. .
7 4] Organize clips..,
4 l"‘ Clip art on Office Online
'I.:l W Tipstor f) -1Ir.g chips

Adding Clip Art
dditional tab, i.e. Format tab
Format tab gives many options to make changes in the picture or

On inserting a picture or a Clip Art in the worksheet, an a
appears on the Ribbon. The
a Clip Art.

Yot Towls  Bookd  Wicriaaf bwes

.."._‘.........Enﬁvu---_ ' a
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Cliek on the left mouse button

sMHAPES

we some pre-detined sh
wal, cube, flowchart, banner.
\:kzxtls'\.‘f

' L ATIOUS steps o add a sh;lpt.‘ are:

Chick on the  Shapes
Hlustrations . group ot

Japes are displaved

button from the

the Insert mb.. Many
on the window )

Chek on the shape vou choose,

at the place in

the worksheet where you want 1o insert the

shape. The shape gets inserted.
you can drag the cursor to in

: : crease
decrease the size ot the shape.

or

CtC. that you can insert "

N i

APes (Autoshapes) such as

i

i L e ]

tJ

_\ Ba 1 Shewan

-\ Bat Ao

LY

formatting the Shapes
make changes in the shape.
N

ADDING A SMARTART

Yping in the text area.
()

l Saa ) Satye refe
i

R I

On inserting @ shape in the worksheet, a Format tab
ppears on the Ribbon. It has various options to

Do en Bl oot e

il |
'!'I i

§
¥

L]
e
L]
Fis

]
»

8
©

o G

«= SO Ul i

-

iy Wk W

Adding Shape

AA = n

SmartArt is a feature in Office 2007 that allows you to create visual presentation of facts and
niomation. It includes a variety of graphics like pyramid, list, cycle, process and many more.
The various steps to insert SmartArt in a worksheet are:

Click on the SmartArt button from the Illustrations group of the Insert tab. A Choose a
SmartArt Graphic dialog box appears on the screen.

Choose the desired SmartArt diagram and click on OK to insert it.
You can drag it to the desired location in the worksheet. You can add labels to it by

@+T-@

(3 p—
=~ 471 )
[ S——
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F-nrm;-attimg the SmartArt
The various steps to format the SmartArt diagram are:
Click on the SmartArt diagram.

Click either on the Design or the Format tab. There are various options availab|, ]
make changes in the style of boxes and the text of the SmartArt diagram.

Click on the SmartArt to add text and pictures.

ey ® ?; o " @9=9 @ -9 0:-0 9=9 ¢-¢ ®=-» ™

. d I a MICRO SOFT EXCEL
After you finish working with the workbook, you can exit the Excel application. To clo

window, click on the button [*] in the upper-right corner of the window. The workbook |

the window will be closed. When you have several workbooks open, they can be closed b
the following ways: |

Click on the Office button and select the Close option [x]. This will close ever
workbook window you have opened. |

If you want to save your work you are working on, you just click Yes in the Microg|

Office Excel box that appears after clicking on the close button [x]. The file will b
saved and the Excel workbook will be closed.

- 30
- — e -

- “ Shreya typed the following data in an MS-Excel worksheet :
A B C D
Roll No. Marks Name
1 101 450 Monika
2 102 645 Seema
3 103 446 Sudha

She typed marks in column B instead of Column D. What should she do to rectify her mistake?

=

L i B loost Rfour $lrain ~
A. Tick (v') the right option.
1. Clip Artisa ... file that can be inserted in a worksheet.
(a) Shape 1 (b) Picture L/,
(c) Figure |1 (d) Text L
Computer Science

Book-7



v AVMESATN Yty fe
¥ ' ! WPy el gy ki d
‘ A
".I'
p
" i-j]-l'-.“F
’.
’ 4 :
, () View
‘ ’y L0 A
/ £ Ml €.
) P ' LRy AT] N 2% line rx f
» 1 SAL, TIevare fvart eve

tOHS 4% g r,-,”rvrj,,/_, T

S 4 Kine ’:.c .:‘E’:-lf";‘lf‘_'

., [b) Symhol

[E—
eat gravhie
2 ’ o [d) none of these ,
ned comnrnand g iser) to
¢ e e | B -
4 ) WOCATE SDecilic Yext in a workshest
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? Fllinthe blanks with the correct word.

SmartArt Fi2 Column three Insert Picture option

w
W
A

W

mNOTKSNeet contains .. worksheets.
“ressing the ey opens the Save As dialog box.
dick on the ofthe ............tabto add a picture.

is a vertical division in 2 worksheet.

zllows you to create visual presentation of facts and information.

- tate whether the following statements are true or false.

s the most suited program for documentation. =

moricsrees can contain any number of worksheets according to user’s need.

e
rt
\
W
4
1y
WV
.
Al
&
@]

‘oriksheets in 2 workbook are Book1, Book2 and Book3

3 2l = 3 intersection of 2 column and a row in a worksheet.

"= mrarsecting 2 shape in a worksheet a Home tab appears on the Ribbon. ]




ye aiow g questions.
\ierstand by MS-Excel?

e W Tk B S R LRE

Ditlerentiate between a workbook and a worksheet.

What is a cell? How many characters can a cell contain:

Write the steps to insert the rows, columns and cells in a worksheet.

2 Write the steps to inserta picture from the Clip Art.

- Whatisa Clip Art

4  Prepare your school time-table in an MS-Excel spreadsheet. Highlight the subject periods
of computer in it. Take its printout and paste it in your diary.

® Insgn a SmartArt diagram in your MS-Excel worksheet. Using SmartArt tools available on
Design and Format tabs, make changes in the text and the boxes of the SmartArt diagram:

Computer Sciencs
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Lesson Extract ]

+ - Components and Types

fr T *“ﬂ
|

Cha o
ooty Cho * Copying a Chart in MS o
modifying @ Charl

jq your previous classes, you have learnt the basje features of MS-1
\-pr'.:udshccl software.

i sometimes becomes difficult to analyze ang compare data in a complex spreadshect and
obuain useful “11_‘3“3“005 from them. In such cases, it is useful to represent these data
graphically. In this chapter, we will learn to create charts in MS-Excel.

CHART: COMPONENTS AND TYPES

-xcel, which 1s a popular

A Chart is a pictorial representation of data in a :_r"‘_!-_j_’_"'_""_I ”50_

workbook, which helps us to compare and Spreadsheet is an electronic sheet
amalyze data and observe patterns and trends in it » consisting of rows and columns. It is
It also helps us to see the relationship between also called worksheet and is a part of
different parts of data. workbook in MS-Excel.

A wo-dimensional chart has two axes X-axis and Y-axis-—representing two different
vanables. Data are plotted on (X, Y) co-ordinates. A chart can also be three-dimensional. in
which case data are plotted on three different variables, represented by X, Y and Z axes.
Components of a Chart

An MS-Excel Chart has different parts
that display its different features.

The various components of a chart are: .

Data Series : 1t refers to the data entries  Nikhil 80 60 75 65

"om which a chart is derived. A chart can  Vikas 75 80 85 55

\¢one or more than one data series. Manoj 80 85 75 70

YAXiS 1t is the horizontal axis of a  Vijay 90 70 65 55

;E?ﬂ It is also known as the Category Raj 85 65 75 80)
s.

~Anis ; It is the vertical axis of a chart. It is also known as the Value axis. The value of cach

C:‘ Point is plotted on this axis. 1; For Your 1i

" Title : It is usually placed at the top of the =
oh. e : y place ‘g You can have as man

AT e Y as 256 dat
ohy E Which helps the users to understand what the = series in a chart in MS-Exce]. e

"' TCpresents. P i . A
ha;sﬁ Title ; ¢ is the title given to an axis. A 2D graph has two axes. (X, Y) and a 3D graph

J dAxeg (X,Y, 2). 75

. ooy
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Chart Area : It refers to the arca within which all chart components are found.

Plot Area : It is the rectangular arca bounded by the two axcs. The X-axis and Y-gx;.
the two sides of a rectangular plot arca.

Legend : It identifies cach data serics. A unique color or pattern is assigned (o ey, (

series to make it casier to distinguish between them visually. .
Gridlines : They are lines that run from each category on the X-axis and from cach valy,,

the Y-axis across the plot area. r
Data Label : This is a label that provides additional information about a data marke, Whi,
represents a single data item or value coming from a worksheet cell. '

e

Chart Title . Marks obtained by some students in a terminal examination
100 Chart Arey
i .
Y-Axis = RO !.’. :
/n .
P 60 ‘] Maths
> 5 50 t m Erglish
= 40 T Legend
10 t Hindl
10
Axis Title |
10 I
o §
Nikhil Vikas Mano) Vijay Raj - X-Axis
. Students
Gridlines
_ A Column Chart in Excel
Some of the most commonly used
charts are:
2 . = ¢ Ll
|. Column chart " :
2. Line chart
3. Pie chart e =
' . i I 1 January Feuruary Marcr A May s
+. ;idr Lhdrl 7 Expected Sales (in lakn units) 10 2] il 1s 9
5 Area chart 1 ACTuAl Sales (in lakn units) 15 10 12 10 3
6. XY Scatter chart ; Sales
[t is also possible to create ’ 1
. g 14
combinationn charts, where two or . 5, \
more different sci, f data can be " 5
. ’ e = i}
plotted in the samec chart using = 28 Expected Sales :m‘akh“l:“
i . 14 £ in lakh units!
different chart types. For example, a ,, % ° — ATHGIAHERIN®
. H = 4
single chart could be used to show the > a
expected sale of a company’s products 17 0!
: i
across two quarters using columns ] g
. =
and the actual sale during the same 2 5
¢ . 21
period as lines. ”

. fts
A Combination Chart Containing Column and Lin€ Cha

Computer Sclence .
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ymie
‘!;lumﬂ chart is useful for showing data
AC o OVer @ Perlod of time or for
Changating cOmMpArisons among items. [p
st arts,  categories  arc typically
colu ..ed along the horizontal axis and
grgagq along the vertical axis. These charts
\,f:fl:u used to compare values across the

jifferent cate gories.

Marks obtained in different subjects by different
sn;dﬁﬂls are shown through column charts

100
EY
80
T
&0
50

~— Maths

English
& Sclence

= Hinddi

Hikhil Vikes Mang| Vijay Ra)

PieC

APie chart is used to plot the data for a
sngle data series. Each data point is
presented by one slice of the circular pie
thart. The size of each slice is proportional
t".the value it represents; so all the data

PNt taken together make a complete

‘Ireular pie chart.

k-lkhl.

20 ao &0 BO 100

i
I'I'_-f'f ! E s S
S ® Hindi
M‘"U] S 2 kY
- u Sclence
Vi .‘“__Fﬁ m English
13 TP Eam— - |
m Maths

- -

100
no
80

o
(IR | ¥
00 | i h u Maths
50 i m English
a0 } Sclence
30 | Hindi
20
10

0 _
Nikhil Vikas Manoj Vijay Raj

A line chart compares trends in data at equal
intervals. It is useful for depicting the
changes in the data over a period of time. It
is useful when you have many points to plot
or when data trends are important. Line
charts are used by people in production and
sales departments.

Here in this chart the trend of marks
obtained by different students in different
subjects is shown.

0%

A bar chart illustrates comparisons among
individual items through a cluster of bars.
Categories are organized vertically and values
horizontally in the bar charts. 1t g very
similar to a column chart. A bar chart can be
described as a column chart drawn sideways,

It is used for comparing multi

_ ple values
through horizontal and vertical bar

S.

Computer Sclpnce H
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S

Area Chart

An area emphasizes the magnitude of
change in data overtime. It is similar to a
line. It is used to emphasize differences
l:retween several sets of data over a period of
time. This chart is mainly used for
representing sales and production figures of
a company.

100

80 *
- *
o L]

60 ¥ i « Maths

30 #l English

40 -
Science

20 Hingt

Now, you are familiar with different types

of charts and the different components of a
chart. To make a chart, first enter the data

into a worksheet.

The various steps to create a chart are:
Select the cells that contain the data
you want to use in the chart.

Click on the Insert tab of the Ribbon to
select the type of Chart you want to
create from the Charts group.

A chart of your choice is made. It is based

on the data series. On clicking the chart

different options are shown in the Chart

Styles group to choose from.

: r ')-!\g_f

100

Manoj Vijay Ra

Mikhil Vikas

XY Scattered Chart

This type of chart is used for compariy,
pair of values. XY scatter chart is useqd Wt
values being charted represent diffe-
measurements.

=
.
- » .
,‘ z B oy de W
s - B 1
1 D Catmn
- Marks o 3 §ive
A g8
; L : o i 1.1
Marks obtained by somae students in an A =
Student Maths  English  Science Y Caom,
foara ) “0 ™ a g 39
Vikas 75 0 ss 83 1 3. }_'
Mano; 85 s 75, T\
» e ° e d
25 &5 % A ] 11 1
iy 1 J )
o, Cong

& 3

e85 8

.Ill lI e

Once a chart is created, several things can be done to modify it. You can move a chart I
different location on the same worksheet or you can take it to your desired locatiol’

another file.

78
PN
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o WAV s o move a chart are:

aeokoon the char ¢ - .
el on NS« ind dldg i o klnothcr l\‘\‘illlol‘l on the same w orksheet.

ocation group of the Design (ab that appear

) a. % on the > Che :
oo N L AR \10\\ \ h\lrl l‘llll\‘n “-01“ [hL‘ l I ( )b
S“'Cd lOL‘;IliUn i!l th‘ i\ll"\ ¢ (‘h;lll hk"x ﬂnd ‘h K :

et you select chart. Choose the de

Wi i
o o b bl bl b bbb, n——

VArous  stleps 1o - :
:.‘; 1,1‘\."\ [l‘l\\ \j\lli.l lll‘:llldt‘li . o -“‘mu-ﬁ' | St Ngly s “
L0 S ol - R i u‘l..‘.I"l“.lll“."“"“"-"-‘lllllllll.lli-'.=‘
» the chart are: i e e — -
' vt ‘lick on  the L e ¥ M DI Y
p 1'".'1‘:‘\- ClIC a1 1T ' Tt N 3e ™ .‘; s b o
L“['l.“-l IL‘ SCIC‘\:t lt- ] ::1 : .-: ‘_‘ : :i ;, e Pt E‘v‘u m.—uw pan sy
. . L TR W ¥ i | | '_‘ lpv b ]
Then. click on the wee 3 ¢ 2 =& Wy 5%
Select Data button o a— s
from the Data group | v i
. : : " - ™ o
of the Design tab of @
. = = o L - e
the Ribbon. A Select » '

Data Source dialog
box appears. Make
the required changes
I 1t

» Changes are retlected
in the chart.

I

[ St s bige wt baLsR e

L

3
i ¥ Py l 3
- L VTS %
a Mg m My
] i
¥ 3 ]
e U |
i ok

Changing Data from Various Aspects

The vanous steps to reverse data from the rows to columns or vice-versa are:

Click on the Chart to select it.
TS

i R B E A

& Clll:k Qn Ihc" S\\ltCh g rw". --‘"o.-c s : Al oL Devgn ;__a_. out -
Row Column button g & = I 1- h ‘3
from the Data group of e e con wer B0 EE = i ba
the Design tab of the =~ - S |
Ribbon. The changes LR N
appear 1n the chart. , N

_ . . Qo o »o W 2 SOV ! My

The various steps to modify the labels and titles are: = .7 sl 5 Al o= -

*  Click on the Chart to select it. N tni

*  On the Lavout tab. click on the Chart Title or the s e

o Comtered Overlay Tiia | H |

Data Labels button from the Labels group. A
drop-down menu appears. Select the appropriate
option from the drop-down menu.

*  Change the Title or the Data Labels and press the
Enter key.

Ti| ©vertey certered Ta 2a
thart withgut fpraing chg
Absva Chart

Cergiay The st icp of
ERAT area a0 Tesaae chats

hicra Tela Cpbtons
Modifying Title and_ E)t;a_ L_GI;E

Computer Science

HAanlk-3

i




CHART 100 s
II‘ >(hart T - s 1 s e 3 . aAre
uh-L Chart Tools appear on the Ribbon when you click on the chart. The tools are loca,.,
ree tabs: Design, Layout and Format.
From the Design tab, you can choose the chart type, its layout, styles and locatigy,

e ii i kR albe bl babdAd by

o e

On the Layout tab. you have many options to choose from and select for your chap -
cannsert Pictures, Shapes, Text Boxes, Labels or different backgrounds to your ch,..

4|

Under the Format tab, you will find many options to modify the Shape Styles W
Styles or make changes in the size of the chart.

[ T
— -~

' [ [ ] w| ] [ . p A

My " | LA, | | ) Ml

COPYING A CHART IN MS-WORD

Once a chart is created in MS-Excel, you can easily relocate it to another place in MS-Wo-

The various steps to copy a chart from MS-Excel to MS-Word are:

@ Click on the chart to select it. >

@ Go to the Home tab and click on Copy button from the Clipboard
group to select it.

@ Open the MS-Word document where you want to copy the chart. dv

@ Click on the Paste button from the Clipboard group of the Home
tab. You get the copy of the chart there.

e
. * Marks obtained by some students In a terminal examination 5
© Tabulate the marks W g -
obtained by the - ®
students of your g o
class in different < B g |
subjects in the @ e R

LRUL L B =

recently held unit
test for drawing a
column chart.

[ ® Label the components of chart.

& "'""E'_'t_'fm" ‘

N Vikay Marn| Vigwy i Ray = -
~ Students




SR ——
(/) the right optio
| LM e . i
' i A neip ) ¥ clarinme i v
S UHANID Detween different parts of data
I" denad - ¢
htild | Uata Label g ) Hile
ot Zontal ax Iacha g
ASO KN Wn as
L 4 ll L3
: : vdaiue axis {¢) Legend (d) Y-aws
a1t arted ielined a
the area withun which all char
! Lall chart ¢ amponents are found
| () the area Within hor iZontal and v ertical axes
t (¢) the area where the chart tt)e Is typed
(d) none ol thes:
.-'.t'\’r ! |I IXS ul !h.t' | ll-l't IS _lI\“ l’\nl\"\[l as
1) Category Axiy (h) Value Axie ive |
| | X (¢) Legend (d) X-axis
\ Chart s used to plot the data for 4 single data series
(4] Pre . [DYXY Scattered (¢) Column (d) Bar
g hilhn the blanks with the correct word.
Legend Bar  X-axis  Analyze  Pie compare
A chart plots datan a arcular chart
\ chart can be called a column chart drawn sideways
A chart helps us to and data
'. is the honizontal axis of the chart
A identiies each data series
(. State whether the tollowing statements are true or false.
I Charts can present information in an attractive manner. g
Intormation represented in charts is not compact. i
The Bar chart shows columns with a conmical shape. |
Data sertes 1s detined as the data on the X-axis. !
-
InMS-Excel, vou can create as well as modity a chart. |
" Answer the following questions.
What is a chart? Why are charts usetul?
. : by : v,
= \\ hl[ are thl' a.]llk'l'l'l'!t'l‘.\' htl[\\'et‘n d ZD'Lth dnd d 3D-Chdl‘l
b Can we have two pie charts in 2D and 3D formats for the same data seres?
1 81 i
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" S itles of a char?
. What are the steps involved in modifying the labels and titles ot <

What is a Pie chart? Write the steps to draw a Pled

= Make a data series on the literacy rates of ditferent states of India.

s Identify the types of chart and name it.

~
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create @ column chart to show the board results of you school for five consecutive years.
create @ bar chart to show the year-wise strength of your school in the last ten years.

Create a spreadsheet on results of any international sports event. Create a Pie chart on
the percentage of medal distribution for each country.

Make a report card of your class in MS-Excel worksheet. Create a line chart to see the
erformance trend of each subject in the last three tests.

Follow these instructions.
¥-axis shows the test number.
y-axis shows the marks obtained by students.
The chart contains a line of a particular colour for each subject.

Rishi'S monthly allowance is ¥ 500. Out of this, he spends ¥ 100 on food, ¥ 150 on tg;fts
7 125 for entertainment, X 75 as charity and the remaining is his savings for the montil.

Create a worksheet with this data.
Create a Pie chart that shows how his monthly allowance is distributed.

Show the percentage for each category on the chart.

. ramauiarSziedco



?1 Lesson Extract

E——
Cell References <« Function Library
Using Formulae «  AutoSum Feature
Functions

Formulas are used to perform calculations involving addition, subtraction, divisiop ..

multiplication. It establishes a relationship between two or more cells. A formulz ;.
expression that can include cell addresses, numbers, arithmetic operators and parentt.

We can perform simple as well as complex calculations using functions.

Formula must begin with (=) symbol followed by cell references and operators. |t
contain any one or more of the following elements :

References : The cell or range of cells that you want to use in your calculation.

Operators : Symbols (+, —, *, *, %, $, #, etc.) that specify the calculation to be performe

> 2

Constants : Numbers or text values that do not change.
Functions : Predefined formulae in Excel.

ELEMENTS OF FORMULAE IN EXCEL

= A2 + B2 * C4 - SUM(E3:ES)

Equal to Mathematical

symbol operators Function
CELL REFERENCES
A cell’s location in a spreadsheet is referred to - Inko
8

as its cell reference. To find a cell reference, <
simply look at its column and row positions in

D15. While writing a cell reference, it is noticed ~ 'ocated above the column letters.
that the column letter always comes first.
) USING FORMULAE
r) tor gour Iﬂgﬂ F l .
| l——— ormulae can be entered in the formula bar*

‘To enter or edit a formulain a cell, you inside a cell. The various steps to write

I -an also press F2 after selecting the  formula are:
' cell instead of double-clicking on it.

-

S—— to be displayed.
| 84 j ——
/  Compufer S¢fence

}‘,

1

When you click on a cell containing
the spreadsheet. It is a combination of the - formula in Microsoft Excel, the formu:
column letter and row number such as A1, B3 or = @/ways appears in the formula b¥

Select the cell in which you want the res”



" the (%) sign 1n the formula bar, It wi]] automatically appear in the selected cell. |
T}, - the reference of the cell whose result is to be calculated and the operator sign (+)-
T}jjs he Enter key. T et | A

i;e result will appear in the selected cel].
5/ Suppose you_have to calculate the value of -
LT 54+ 45. 54 15 placed in Al cell and 45 is Ipboa
Iyped 1n the‘A2 cell. Then, the formula for cum = v o [ =Al+A2
( } this calculation would be = A1 + A2, which . . z D

J ™ you can type in the Formula bar and press
Enter key to get the result (99).

L9, B S PV N Y
1 T %
p=4
-

*

|‘0110Wing arithmetic operations are used in a formula: Entering Formula
he

operators Operations Forn::;l; '}1"5 ey (If Al =1:33:r1:1 A2 =2)
A Exponent =Al~A2 10° =100
* Multiplication =Al *A2 10 x2=20
/ Division =Al/A2 10/2 =05
+ Addition =Al +A2 10+2=12
Subtraction =Al —-A2 10-2=08

.

Slomclimcs a formula displays a result such as #VALUE! rather than the result it was
ntended to display. # VALUE! is a type of error displayed by MS-Excel. Some other errors

that MS-Excel returns are:

Errors Possible reasons

HHHH The column is not wide enough to display the numbers.
#DIV/0! The formula contains an invalid operation — Division by 0
#N/A Data are not available

Afunction is a built-in formula in MS-Excel that is used to carry out common mathematical
calculations. Functions save us from writing lengthy formulae. Excel can be used to perform
lasks such as finding average or sum for a range of numbers.
In Excel, we should write function in a specific order called syntax.
_Func‘lions should begin with the (=) or @ sign followed by the function name. SUM or AVG
@ function name.
The third part is arguments. It can be numbers, text or cell reference. Arguments are enclosed
¥ithin parentheses (). When there is more than one argument, each is separated by a comma.
ﬁ
| 85 ’
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Eagual s SUNL (Y i - g o L or Yo ‘ :1;.
; ; Formulae & oty I
| FIODNA'S ke for gy,
I his s an example ofa e ton st one argament caleulatione. l
ol spn AN GoIRY T, OV 10) - AT
Fum ton v
Phas s an example of a funetion with more than one argument T
_ : , . K
Phere are vanous predetimed tunctons e MS Exeel which we o .
canuse Some of them are given below ' B
Sum  Adds alleells mthe argument Pl
Average @ Caleulate the average of the cells m the argument L Sy
Man : Finds the manamum value | e n
Count @ Finds the number of cells that contam a numereal value Wik 0
Avainge "

within a tange of the arpument
Ihe vatous steps (o use a tunction are
Click on the cell where you want (o apply a function,
Click on the Tnsert Funetion button from the Function Library group of the Formulas )
of the Ribbon.
An Insert Function dialog box appears.
Choose the tunction and chick OK.

i Aol Bl

oy ™
e, Pags | |
E [~ AT )
. \ ) v y (|
AR o A " |
'\ - \ wil . P I
Al v 2 K v||
i 1] ! (4] I | (1] | I . r
) | adin fae @ e
| Ry T F I S TR T e |
| | e mat b gy M Ry L) - ‘
' : Gt 8 A
s D .
\ L i S TS T BT e S
L] LY LN ] A
W0 ¥
? HYPEAL P
11} vk
AL |
. i ! . |
0" L e ( ‘1‘] |
i Akl 0 I (T on 1 g of Gl
in |
1] \
T
1] | " b
. biadp aol hak fumtiog
warm \h.-‘
(T}

Selecting Appropriate Function




Fuﬂcti‘)ﬂ ments box appears on the screen.
M i in the :um§er21 EOX f(.)r the first cell in the range that you want to calculat
i o ) alculate.
cilin the utm ci); with the last cell in the range that you want to calcul;a?ee
r m ' :
Jou M2y enter MOTe then two arguments in the same way, if required. Click on OK

buttOH- . ,
. result will appear in the ' T

Selected cell.

L L M)

Fancton hrgures - "q

6 |
) | 45

{ SAH 0 O A B b o AR
ek k] wbwh d § 15 S e 14 T e bt il ek o Pt

o dait, widadad f tped 8 WL

M ]

T \I_.|-.' A e

Entering Function Arguments

FUNCTION LIBRARY
The Function Library is a large group of functions on the Formula tab of the

functions are available under the following categories:
AutoSum : It calculates the sum of a range of numbers.

Recently Used : All recently used functions are included.
Financial : It is a list of financial functions such as accrue

additional financial functions and others.
Logical : It is a list of logical functions.

Text : It includes text based functions.
Date & Time : It includes functions to calculate date and time.

Math & Trig : Itis 2 list of mathematical and trigonometric functions.
And there are other More Functions available in the group.

1/

Ribbon. These

d interest, cash flow return rates,

Home Insert Page Layoul Farmulas Data ReuiEw ACT

% Z () @ @ - g o o

autoSum Recently Financial Logical  Text  Date & Lookup & Math & Mare

Insert
'J',M| . v : - 1 > e
Nme - Peference — Trig © Functions -

Function
Functiog Lo

187}
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AUTOSUM FEATURE
The AutoSum is a short-cut feature for using MS-Excel’s SUM function. It provige. 3.
Way of adding up columns or rows of numbers in a spreadshect.
The various Steps to apply AutoSum feature are:
Enter the following data into cells C1 to C6 : 11,12, 13, 14.15. 16,
Make sure that the cell C7, the location where the result will be displayed. 1< 51,
Click on the Home tab to select the AutoSum button form the Editing g, .
Ribbon to enter the SUM function into cell C7.
Drag the mouse to select cells C1 to C6 in the spreadsheet.
Press the Enter key to get the result. The answer 81 appears in the ¢!l €7

Click on cell C7 and the complete function = SUM (C1 : C6) appears in the form,
above the worksheet.

- | - - o e a |
L] ) g1 3 . | “ % s, mee
— . -
i x

=S Uﬁ__. 4 f 4
/= -. ! . I & 7

|

|
) l; '
e ]| - o | - - -

»
|
|
|
|
|

— |

- Circle the various categories of functions
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(/) the right option.
N error indicates that the column is not wide enough to display the numbers.
(a) HHHHH (b) ### (c) # " (d) none
................ is a kind of error. o o
(a) # N/A . (b) %%% L () xxx L (d)none

A cell referenceis ................

(a) its location in the spreadsheet.

(b) the name of a cell in MS-Excel.

(c) a group of cells in a spreadsheet.

(d) number of cells in MS-Excel.

AutoSum feature is used to ................ .

(a) add numbers in the selected cells. | (b) subtract numbers in a given cell.

(c) perform logical functions.

A formulais :

(a) a sequence of values, all references, functions, and/or operators contained
in a cell.

(b) used to carry out common mathematical calculations

__, (d) none of these

(c) defined as a group of symbols.
(d) none of these

Fill in the blanks with the correct word.

Home Formula calculations HN/A =
Formulae are used to perform ... ;
A formula always begins with an .. sign.
AutoSum feature is presenton .. tab.

error indicates that data are not available.

........................

The function library is on the e tab.

State whether the following statements are true or false.

L.

The function library is a small group of functions.

There are various prede

Formulae must begin with 7 sign.
# Div/0 indicates the formula contains an invalid operation—Division by 0.

Formula can be entered in the Tool bar.

fined functions which we can use,

~.Computer ctence
7 7 ook 7
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D. Answer the following questions.

Whatis a Formula? Explain with the help of examples.

What is a cell reference?

Define Functions.

Name any two error results displaved in MS-Excel and state their possible reasong

Describe any five functions present in the Function library on the Formula tab of g
Ribbon.

% Calculate the sum and average of the marks obtained by the three students in
different subjects. Use functions of MS-Excel to verify your answers.

st L Hindi | Maths [ Sdence | SocialStudies ] Sum Average
Ria 70 S0 60 64 50

Agrim 80 58 74 88 86
Kriti 96 92 78 80 82
" .\\
¥ ‘. 1 '\ T———y
l ’ NB*\/je = =
e

—

~

& Make your report card in MS-Excel and ¢
AutoSum feature of MS-Excel.

alculate the total and average marks using




| 7 pe— ;

esson Extract ]

g | |.L.‘lbh:.‘:l

=T

Wh\ﬂ I :
opminu Flash
e workspace :

" (elting Document Properties

Applying Gradient 1)
Crealing ¢ New Gradien|
Modilying a linear ¢

_ Fdiling;()hj(}: Is
prawing an Object and Grouping Oulline

mporlineg Careaphie s

s

Anirmcation in Herh
radion| o linl I‘Nf:r;ruur]
Crealing a Simple Tesd

wilh Fill Shape Tween

WHAT IS FLASH?
Flash 18 & powerlul animation software pack

- : o _ age developed by Adobe Systems (formerly
vlacromedia). Flash provides a versatile

. : and casy way to create animation that consists of
images, S(mnd_ and video with various effects. Flash is a vector based program which means
tat the graphics created in it can be scaled 1o any size without losing the quality. Flash is
extremely uscful for developing  highly interactive websites, online advertisements,
computer games and contents for various mobile devices. One advantage of Flash is that, we
can play the movies in any browser.

OPENING FLASH ”Fl il

o C(Click on Start > All Programs > Adobe
Flash CS3 Professional.

® The opening screen appears.

® Click on Flash File (Action Script 3.0)
under Create New scction to open the flash
document.

|
|
|
| aeimy aned .

THE WORKSPACE _ i
Flash is similar to the Paint soltware Ja

Windows. It has almost the same tools that Paint |
uses but it is mainly used for animation. -
The ‘workspace’ is the arrangement of various Flash clements such as the Tools panel,

Control pancl, Property Inspector and Window.

Dol whion agan

Opening Window of Flash

we can create graphics, animation, make modilications

The stage is a drawing board where |
B esent at the centre of the workspace. By default, the

init. It is a large white space that 1s pr , ‘
stage dimensions are 550x400 pixels. The gray arca surrounding the stage is called the Work
- A h s . : . .
Area, where we can also place the contents and animate them. We can change the view ol
k] « iy . . - i §
» Stave size kv colecti ow > Zoom in and View > Zoom Out option.
the stage size by selecting View > £

91
‘ Computer $clence h':l;
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1 his | damas |

Moperty "o =
Inspecton ; ' - v
Winilow
Menu [ ash Workepece
The menu contams  controls o For Uour ["6/”

common functions  hke opening:

. 2 e Coy s considered
and saving, files as well as specilic

Jonatlhian

- ; : : ; 0 the  maln programiner
functions like copyiny, and pasting, 7 8> ) wistarary of Llash, 8
calling up  specithe pancls I:uul | arsmatten edlior far  weob
controlling. — the —overall lash DAROS.
1

cnvironment.

Tools Panel
The ‘Tools pancl consists ol various (ools 1o draw, paimt,
I 15 divided ito four parts

select and modity

objects in the workspace. The Tools panc Tools,

View, Colors and Options.

The Tools section : [t contains tools that are used for drawing, panting and

selecting objecty

The View section = 1L consists of tools for zooming and panning the application
window.

The Colors section : [t includes modificrs 1o select colors for the shape you
draw usig Stroke and Fill Color picker.

I'he Options section : It displays modifiers for the currently sclected tools,
Modificrs alfect the tool’s painting or editing operations.

For Your I"‘KO :

The default extension of Flash file i (1,

-

—
(92 -
i ‘Compuler Sclence
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Sk foe
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Tools Pane!
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e is a fixed window that stays on t
0

P

" ITiT"le ntrols the f
1 s and €O content of a docume P O every object in the workspace. It
orgﬂ“‘com onent of the Timeline are Fram nﬁovemme in frames as well as in |'d-ypf Th
o €S, Lavers ¢ " i ) yeis: ©
0l Called prames and field labelled as Layer | yers and the Playhead. It has a ruler hke 2
P Jpyfeane Timeline '
/ Frame
et enD . L
. 7 B .
..Ers Frame Ra}s Elapsed Time
Y % Edit Symbol 2097
5 I 12ofpl ot .
: £ oseene L
. ) ’
- The Timeline
prames

pimations 10 Flash are created with the help of frames. Frames in Flash can be defined as
ihe little rectangular cells that appear on the Timeline. Each frame has a number, which you
can find on top Of the Timeline. Like films, Flash document divides the length of time into
fames. A frame displays the content of the movie at a specific moment on time.

o For 9?:‘;.%_‘ I

"w Different versions of Flash have been released till now, from Flash 1.0 to Flash CS6 *
- Professional.
| Flash was earlier known as Animator Future Splash, until Macromedia Inc. bought the
! company which developed it later on.
Keytr‘m‘nt'-:t, a | _
Keyframes are special types of frames where We define , s w0 15 B
some change to an object’s properties for an animation— Key%raime - Cortent
like position, color, shape etc. We can easily change the __-—_.——_—_—_——'________:.‘ ' '
length of a tweened animation by dragging a keyframe in (Empty Keyframe, |
the Timeline.
Layers
Layers are like multiple fi

another, each containing a

Im strips stacked on top of one
different image that appears on ¢ @ o m (1 20 120fps 16

the stage. _ _ Two Types of Keyframes

A layer contains its oWn timeline with end}ess frames. It

could be defined as one independent movie of only one (Play Hiead)

level. ) _ | @Q?MQ“JEI s 0 15w
h document, 1t contains only 1% - vl

When we open a new Flas :
one layer. We can add more layers to organize the artwork

and animation in 2 document. We can draw and edit
objects on one layer without affecting objects on another
layer. The active layer is indicated with a pencil icon next

3 The PlayHead
to a layer name in the Timeline. y r§—3—1

P | e—ry
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~ } 1Ay hf.{“i Lt atse th » i l
| SO The current frame display e

Y wa 3
- A4 Oy by s
= s 1 _‘“.\\.\\\ .

on lh\' NRTUS ”“‘ l‘ll.l\ |h'.lt| [lIU\l.

l rp % o et
N apern lll\p“[u[ 1‘.1‘\..1 that dl‘-;‘l ns the prope thies ol the selected "‘l‘lui
SVULoan image, g

1n~pozor You ca

\'\\

hne or a shape). The hist of properties also very e the Py,

I . attributes )

Ins an make changes to the object or document attribule the Ilnlm.,.

nspector, -
- et Sre S0 N 400 paels Background . frame rate: 12 I
IR Dhiseh Sellings Maver: 9 Actronsenpt 10 trofile. Defaul

v 0

Document dass
The Property ,'_r!_\pt‘t‘[ﬂf

SETTING DOCUMENT PROPERTIES

.-..\\n-

Cach nme when we \\p\ n Flash, the Jpphc;umn opens a new tile with the detaul setlings
e movie properties. We can create a new movie as we work, To set the frame gy

-\\-\'-‘.

backg round. color .md ruler units, we use the following steps :
Cliek on File > New. The New Document dialog box is displayed.
Select the Flash File (Action Script 3.0) option in the Type list. Click OK.
Select \lodlf\ Document. The Document Properties dialog box appears.
To change the Frame rate, specify the speed of a movie i frames per second B
defaulr the frame rate 1s 12 fps (frame per second). Type 8 tps in Frame rate boy.
¥ To spec t\ the stage size n pixels. enter the values of width and height w
Dimensions ext box.

‘e Dace—e “ . =
S e . f
N l - | | e
a e g | : m.
W T T L T ap— fa"  Pé Sl
Q e : X B -comiian T5¢ Piblts. Seligr SET0 LIt i
S ¥ - = Meowt ) OEAEY AauTantt 1 M L e add
S Tie ' Flac
= oy Sy T e Flash DOLUI’T\E_P_I'(‘ B85 T WS B A0 e : o
L e /Dlrm‘n.~.|nm
T - ' f
- s dimansans, ™ (wslth W e

Match Printer @ Defat

Background coler R E\'it‘kgh.'l'.ll"ld color
AR -

|
|
i
|
. Frama rate 12 ‘f,";.'" Frame Rate

e Ruler LT

Ruler unity: Py v

Make Defaut o e

o P

— New Document Dialog Box Document Properties Pmu g B
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. backgrou ¥ " X - o
fo set the background color of the document, choose any color for the stage from the
Backgruund color swatch. -

<ot the stage size to the maximum available pri o

Ii;L;L click the radio button Prints; al:r?él:rm;lg?cnht IELT)

gection: ) The shortcutto g
gelect the unit from the drop-down list of Ruler units. ~ insert a frame

Click on OK after specifying the required options.

RAWING AN OBJECT AND GROUPING OUTLINE WITH FILL
JR*

when We make a drawing in _FlaSh‘ it_ actually creates two objects—the fill and the outline.
“ nanipulate clements as a single object, we need to group them.
Gelect the Pencil Tool and select brown -
45 the Stroke color and Fill color. 9
Draw the stem as shown in the figure.
Choose the Selection Tool and move
the pointer on the tree trunk. A curve is
displayed below the arrow. Hold down -
the left mouse button and drag the lines = “Smooth Mode
to give a proper shape. ¥ =
Select the Pencil Tool and select
Smooth mode from the Options
section.
Select green as the Stroke and Fill
Color. Draw the curves of the tree top .
) - 2
as shown in the figure. A
Select the Paint Bucket Tool and click
inside tree top. Similarly, fill brown
color in the stem.
Select the Selection Tool and double-
click on the tree top. Drag the tree top
over the tree trunk.
Choose the Selection Tool and then

select the tree by dragging around the |73
tree. |-

) For Your Iu{o

"l Keyframes can be of two types. If a
» keyframe has content in it, then it is
' Tepresented by a dark circle.
. An empty circle preceded by a keyframe

) presents that it is an empty keyframe A Dragging the Object —

________________________________________ 95
Computar Sclence e L—il I
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Selecting the Smooth Mode of Pencil Tool

Filling Colour in the Object
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To select both the objects, choose the Selection Tool, hold down the Shift key 4
double click on the abjects Then select Modify » Group

APPLYING GRADIENT FiLL

r ]
Oradient means filhing color inoan objedt from b
dark that basically pives shade to an object or a4 cal
formed by miving of two or more color i an
L4 .
Sclect the tree using the Selection Tool. 1
L] N P H
Select the Paint Bucket ool
. o g i
( Iu.,k [}“_- }I" ( olor 0 wp-down arrow o get the .
color paleng
» cinloager g
Select the pradient effect and chick inside  the | .
et The gradient color £ the '~.“~’p‘-' \oplying -

PN can create two tvpes of Gradient .t B L)

The shortcut keyto
display Document Ctri-

linear Gradient changes color trom the starting point to the end pomt i a straght
Radial Gradient changes color in an outward direction starting trom the tocal pont

create a new gradient. tollow these stepr

®  Seledt the stem of the tree
Yo Choose Window > Color Miver 1o Iﬂ&l
lisplay the Color Mixer panel i O S N T 8 18
. RLLARLY) Wap SiZe 0% I8 i

. ( lick the dr P down arrow of }'l" \l\l(’ toand madmum s B8 < JRE) els
nox and select Linear or Radial.

®  Double-chick on the lett color marker The color palette appears Select the brow

o Select the Paint Bucket Tool and Click on the stem

3 !)uuriu.’--. HOek o Thc .'.e_' [ MO MIATACT andd select the oranye « n|..;
® (ick the drop-down arrow below the Free Transform lool and sclect the Gradient

Transform Tool trom the Tools panel. € Lick on the stem tilled with a gradient nill |
gradient transtorm controls the appearance on the stage around the object

To rotate the pradicnt Bl dray the Gradient Rotate handle 1o rotate the hinear grdicrn

clockwise as shown in the hpure

® A bounding box with editing handles appears

|



Fill Style Box
S
’ Type: Lnear ¥
overflow: . v
’ - Linear RGB
"
4
v
c 0 e
o 0
L v
s 0 . = :
§ v *000000  Gradient Bar’

Left Color Marker Right Color Marker Gradient Rotate
color Mixer Panel
, Toscalea liner gradient or a file, drag the @/ I".EO‘
square handle at the centre of the boundary [t is not always required to draw an

box. + object on the stage and then create an
, To change the focal point of a circylar | @nimation in Flash. If you want. Flash

oradient drag the middle circular handle on | ¢an also be used to create.animations
[:fle bounding circle - from external images and bitmaps.

MODIFYING A LINEAR GRADIENT

Draw a tree on the stage and fill a linear gradient color in it. Let us now modify the radient
flled in the shape by using the Gradient Transform Tool.
¢ Select the upper portion of the tree.

Now, select the Gradient Transform Tool in the Tools Panel. Click

the object filled with gradient colour in it.

The shape will appear as shown below:

Rotation handle
This is the Centre point of
the gradient

- Width adjustment
handle

Modifying a Linear Gradient

Chare:
Mging the Centre of the Gradient

 Centre point of the gradient is the place where all the mixing colors are present in equal

Empm‘tion. To change the centre of a gradient, use the following steps:

Bring the pointer over the centre point. 573

‘ ‘ ""-"':t':fsllln . BN




- o= ey N

‘ ange e postion angd .
['\1‘1}\. the cenie pomte m o desued Jduechion o vh i} o I1|!..-|~_|

changes

Changing the Centre of the Gradient

To change the widih ot the pradient [lled mside the shape, follow the steps pivey beloy

Position the pomter over the width adpstment handle Towilb chanpe o a dogbe hey
JUTOW

Drag the adjustment handle o the left or vight (0 merease or decrease (e REy
Wudth

Changing the Wadth of the Gradient

lo rotate the gradient color filled nside a shape follow these SICps:

“ Posion the pomter over the Rotation Handle. The powter shape changes o U1

o

Drag the rotation handle clockwise or anticlockwise according, (o the need and obsa
the changes.

Rotating the Gradient Fill
Modifyving a Radia
Likewise, vou can modity a Radwal gradient color filed mside the tree. et us now ol
the gradient filled in the shape by using the Gradient Teanstorm Tool.
®  Sclect the upper portion of the (ree.
®  Now, sclect the Gradient Transform Tool in the Tools Pancel and click on the abyed
®  The shape will appear as shown at the next page.

l 98 B
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radient : You can
nt to change

r @
cent® | centre poi
f color

draBl in point ©

thf‘lsiarﬂf the gradient. Width adjustment handle : You can

drag the width adjustment handle

ﬂ‘ll!m
to increase/decrease the gradient
width. .~
=
| e
I ; -_.f'
&l
\ “,
\ '
dle : You can drag the S ———— o

Resizing handle : You can drag the
diagonal resize handle to alter the
gradient size proportionately

o hat

ise to o2

kwise or N
te the gradient R

Modifying a Radial Gradient

ITING OBJECTS

- odit an object, W€ have to first select it, otherwise the command will not be applied.

Click the Selection Tool.
Click and drag the selection box around the object and release the mouse button. Or

Double-click on the object to select both the stroke and fill. The object will be selected.

sng the Free Transform Tool, we can scale, rotate, compress, stretch or skew lines and
upes. To compress the drawing, follow these steps:
Draw a hexagon using the PolyStar Tool.
Select the Free Transform Tool in the Tools panel.
Double-click on the hexagon on the stage to select the both stroke and fill.
Drag centre handle of the Free Transform Tool down to transform the hexagon into the
following shapes.

Using Free Transform Tool Skewing a Polygon
. ﬁ
Using Free Transform Tool I 99 I

| Computer Scionce Gaondl
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Rotating an Objeci -

Follow the given steps to rotate/skew the object: : EH:\
Select the object. }/ I
Select Modify > Transform > Rotate and Skew. A 4 I
Click on the corner handle of the object, the pointer I, ", :
changes to rotation handle. L /!
Drag a corner handle to rotate the object. | '\7“‘“—\“

To end the transformation, click outside the selected object.
An outline of the object appears as you rotate. Rotating an Object
Release the mouse button and see that the object has rotated.

Draw a fish using the Pencil Tool and fill color in it using the
Paint Bucket Tool.

Choose the Selection Tool and double-click on the object to select
it

Select Modify > Transform.

Then select Flip Vertical or Flip Horizontal and observe the
change in the object. Flip Horizontal

Select the object that you want to copy by using the Selection 3

Tool. W Copy
Select Edit > Copy. S
Click on the blank area on the stage. N |

Select the Paste option from the Edit menu and you will get a 2
duplicate copy of the object. Paste

e

Select the object that you want to move by using the : ‘ """"
Selection Tool. o

A Plus sign appears next to the arrow. | T
Click and drag the object to a new position. >
Release the mouse and you will see that object has
moved to a new location.

IPORTING GRAPHICS
Select File > Import > Import to Stage.
You will get the Import dialog box.
Browse the filename to import. Select the filename and click on Open.
The picture will be placed on the stage.

Moving an Object

100
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Importing Object

f&l Q '.ll"._ﬂ_.
The shortcut key to

import a picture Ctrl + R
to flash

\pimation involves a series of still images,
:muully painted or sketched, displayed in rapid
,{,qucncc, Then only it appears to show some

povement.
mimation in flash is created by changing the contents of successive frames. We can make
mobject move across the stage, increase or decrease its size, fade in or out, change color or
shape using animation.

There are two methods for creating an animation in Flash:

frame by Fi ration

nFrame-by-Frame Animation, we create an image in every frame.

Tweened A

the Tweened Animation, we create the starting and ending keyframes to animate the

In
Wject. Flash itself creates the motion effects in between the frames.

b

Tng Tweening is used to change the color of an object. Tint effects work only on symbols
M cannot be added to the object that are drawn directly on the canvas of the movie.

To create 4 symbol, select Insert > NeW [create newSymool e

Symbol. Hame: Tex] | _‘

TI)\’IPE: 4 name TEXT for the symbol in the Bpe Vg -
Oamg’ field in the Convert to Symbol dialog © Graphic prme—
X. Select i ion in behavior and

click OKC Graplie QUG i b Create New Symbol Dialog Box

Seleg the Text Tool in the Tools panel. Select Text > Font > Arial to set the font type.
. D0se Text > Size > 48 from the menu to set the font size l?lg. Select _Teﬁxt Stqu >
old ¢, make the text bold or you can make changes in formatting of text in ‘Properties

dia)
%8 box’ as shown in the given figure. ' \

|101|
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rroperties « | fittars | Parametes |

T | Static Texy v A ana v 44 v /B 7 E®AMWy -~
Y o !.'l Al Hormal v  Anti-alias for readabiity i

a WiB0e g - / N e

Property Dialog Box

Now type the text—Express in the work area.

N0

5y
X
WA

4oy boao o ri 36 150fm 48 o I 5a
™ - e
dz " Seens | /

A 4
LI H

Library Displaying the EXPRESS Symbol

Select Edit > Edit Symboels. You can change the properties of the text.
Graphic symbol automatically saves in Library.
Select the Frame 30 in the Timeline and press FS5.

Insert a keyframe in Frame 10 and Frame 30. Position the pointer on Frame 10 ther |
press F6. |

Repeat this step on Frame 30.
To add Tint effect, select Frame 1 and click on text. l

Waliliedsd*
wald i ih 1" 7
4 o M :
2. | - .
N
A [ ¢ LOTIgs  ada i " ———— e
; ;JM ;ﬁm“ I Color: ler‘:t — v] W s0% v
' None o -
Y First: 1 RGB! grighinass 0 Iv'
4 L .
o (= v [ Bland; Alpha
e l ' £ J. Advancad
. - —"
Selecting Tint Option
[102] 7
102
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property Inspector, select Tint color from the Color
c

- : option list. Position the
o mount bar at 100%. You will get the color m

ap. Set the colors to Red = 255,
inf 27 0. Blue = 0 (RGB Colours).
foizrh_ add Tint tweening to keyframe 10 and set the colors R= 0.G
g

=255.B=0.
it rweenting to keyframe 30 and set the colors R= 0. G = 0.B =255
A

" click on the Timeline at any place between Frame 1 and Frame 10 and select
g;ghate Votion Tween option from the drop-down menu.
Creatt* T ——— e o
=ap

L I | 4 4 | N e _______I Th e

LR a8 000 Tade

3T P

g :_: 't 1. <

/ .( - 0 E I 2

= :. ) 2 i 38 4 sl Lp »e

A o - = Scene | PRI

A = -:

5' ; ._“‘-.. R R e T

.r :

F a2l

Actand

Selecting Create Motion Tween

Similarly, right-click on the Timeline at any place between Frame 10 and Frame 30. and
hoose Create Motion Tween from the drop- down menu.

Click on Control > Test Movie and view the Tint tweening effect on the text.
i?EATING A SIMPLE TEXT SHAPE TWEEN

"' . - -

th Shape tweening, you can change one object into another. Let us try:

§[clect the Text Tool T and choose Text > Size > 44 from the main menu and select
“Xt> Style > Bold to make the text thick.

C(l]'u can also select the font, size and style from the Properties panel.
i

disle on the Text (Fill) color in the Properties panel.
Played. Select any color of your choice.

The Color palette will be

g, -
‘.' | Fittars | Parametars e
$ ®
| T tatic T&';Q i | A Arial - 44 .Ivl ',, i n] V4 |m & 3 ] 1‘ 5'
Te .
A ol Y g H M nermal w | | Antealias for readasiity v

V| Auto kdrn

Properties Panel
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D the ol on the Stage 1 the finst frame of the mam Limeline Noogs “ln
\lign o \ \lign :xi::.cl. sq.r.: the To stage burton Chek the Align Hl‘rl
Center bution and Align Vertical Center button: Close the Align panel

R — - we

& LJ‘E

ahdd Fer
- -
,.. -

- e

' “‘ .
s l

la -

\\_-af~\4 s-"t"lt
L

Move the powter ar Frame 49 and :"lslhbchc.\ the mousc. Salect Insert Key fran

\v\:: '1'\ F’v"\t‘\ 'h \ b T T T -\ YN NTREY
. 2 - ‘ i Liae

Sumlarly, Insert Blauk Neyframe at Frame 24
DA sone new et and then .1.:5:11 Horizontal Center and Vertical Center.
clavt the et in Frame 24 then select \ludu‘\ > Break Apart.

DICAN apart the ext n Frame 1 and Frune 4

Sy

ei'a s SN S e .
wospaet & & ER e e

Tl T T G s O i’
sering Ayframe gt Frame 49

Click between Frame 1 and Frame 24 in the Timeline.,
G0 1o Properties panel and select Shape from the 1‘\\ een drop-down menu.

Then chick berween Frame 24 and Frame 49 and select Shape again trom the That
drop-down menu.

Select Control > Play option from the main menu to play vour animation.

oo Tl Samacg | Saedamates
5 ) ¥
- -.“ . } LY ' ‘_ T .
ir—l— Zams 2en  Nohe S0und: None X
o Wane
Moton Bffect: ‘wne v

Shape | : . Y
Lade! tvpe Sync: Event v Repex ¥

Selecting Shape Tween
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J
3

P e SprlzortCUt to insert a keyframe is F6.
7o make the Properties panel visible on the screen press Ctrl + F3.
: 7o gTOUP the selected objects, make use of Ctrl + G key combination.

e shortcut of the Pencil Tool is Y and for the Selection Tool is V.
_ The shortcut key to use Free Transform tool is Q.

_ the shortcut key to import a picture to flash is Ctrl + R.
_ The shortcut key to convert an object to symbol is F8.

- ctrl+Enter is the shortcut key to play an animation in Flash.
. F7is the shortcut key to insert a Blank Keyframe.

2
+ S
.\i' O0OSL OLul

)
&

, Tick (v') the right option.
I Which of the shortcut key is used to insert a frame?

(a) F2 (b) F5 (c) F10 (d) Fé6 iy
2. Which panel acts as a store house in Flash?

(a) Library ., (b) Tools

(c) Properties ___ (d) None of these -
J. What are the little rectangular cells called that appear on the Timeline?

(a) Frames (b) Layers

(c) Keyframes (d) Stage =

Which shortcut key is used to play the animation in Flash?
(2) Ctrl + Alt ., (b) Shift + Enter

(c) Ctrl + Enter ___, (d) None of these

Which is the extension of Flash?
b Rl i(aJ la (b) .flash (c) -fas (d) .Fas [
N the blanks with the correct word.
| Workspace Work Area Stage Timeline Animation Adobe System

3 lash i a powerful ....................... software package developed by ............ccccc.....

k Egitrolp is the arrangement of Valrious Flash elements such as the Tools Panel,
3 anel, Property Inspector and Windows.

T};lz w18 a fixed window that stays on top of every object in the workspace.

The gr is the large white space that is seen at the centre of the workspace.

ay area surrounding the stage is called the ............... gy |

|105|
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C. State whether the following statements are true or false,
lonathan Gay is considered as the main programmer and visionary ol Flash, |
The shorteut key to import a pretuare is Curl + G,
Radial gradient changes color in an outward direction starting from the focy)
pot. L
Rotation handle cannot be dragged clockwise or anticlockwise., [ i
The default stage size is 550 ~ 400 pixels. |
Tools that are used for drawing, painting and selecting objects are presentin
View section of the Tool Panel. L
D.  Answer the following questions.
What are the parts of Tools pancl? What does the options section of Toolg Ding|
display?
What are the default stage divisions displayed on the Flash Window?
What do you know about Flash?
What is the difference between Frame and Keyframe?
What do you know about animation?
What do you understand by Gradient? What are the types of Gradient? Name them.
What is Tint Tweening?
el
£ )
Computer §clence
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Create your school logo in Flash and add it as a symbol.

(reate a Flash animation to create a Tint tween effect on the text.
Type “Express Screen Fun”

Select the font Times Roman and font size 56. ' -
Ueate a simple Text Shape Tween
|
P RIYA |
Type your name |

For example : RIYA in Frame 1 and JAIN in Frame 20. | JAIN |
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i Lesson e ]
| Extract sommm— ce Uses of Internet

Introduction to E-Commerce
Advantages of E-Commerce
E-Commerce Sites & Ethics

Advan
. Chatfing

E-COMMERCE

You know about the term commerce. It is involved W1
can see commerce all around. It may take different fo

th buying and selling a product Y
rms. Three different types of PGOpJ;;»

are involved with commerce. These are .y For Your
Prodt '
o 1cers ‘m URL stands for Uniform Resource Locat,
ellers l It specifics the address of a website.
Buyers

Commerce revolves around these categories of people. _ .
Producers are the people who produce different kinds of products or items and services
Seller are the people who sell items or goods and services to people.

Buyers are the people who purchase items and services.
For example, Amul produces Amul Chocolate, which the shopkeeper in your neighbourho
sells and you buy it.

So, Amul Company is the producer, the shopkeeper is the seller and you are the buyer.

Electronic commerce or E-commerce means buying and selling any product online using
the Internet technologies. Many companies have set up their website, which provide th
facility to order and purchase their products and services. These websites, which provid
E-commerce are specially designed and have some extra features.

N .. "TECH
| ON A C INGET
50 .h”_

EEEE——

F1 (TS
FROM POPULAR
FRANDS b

Sy row -

|
| -
——— - h
Kool www.ebay.com www.quikncom
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. modes of E-commerce available at present. These 3
ec

= are;
,thr
1re [h

< ¥ o-Business __
I -Customer i

e P

v

psiie an.

: 1l Middlem

i

t0 Business refers to a company
.04 8= . vi
w;mfor buying products or services from
iné

27 ompanies:

- |
. | o ——
www.walmart.com
- n b - —
t h«g 7 -Houoavsaes - 5§ Business-to-Customer refers to a company
e ???m'e_ “ g SAVEBIG &' which establishes Website for its products
PR o tereteagn

and services. The customer can order any
product or service and also

gather
Vo information about these products and
services
www.hp.com E; a] y.com
igital Middleman refers to a company Lﬁ_ 4 Internet Search Engines
uch provides information about several | E M search Toos
mpanies on a  single website. This @g_, e -
many gathers information from other || s
‘panies about the same type of products | == |
‘%vices. A commission is charged for ‘ -
Y sale or purchase by the company N
ing the website. = [|

www.freality.com
WaNTAGES

OF E-COMMERCE

| advantages of E-commerce. Some of them are as follows:
*Wdo not need to go to showrooms or shops.

" do not need to carry cash from home to shop with a fear of losing it.

" do not Dieed to search an item manually with the help of a sales person.

wozz or€ no geographical and time barriers. You can buy products from anywhere in the

b
iKre are SeVera

v f \
Cn Sma]] COompanies can go global |109i !
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Yo :
U do not peeg o travel to other countries for purchasing products.

me, money and effort.
€ products from all over the world.

You can saye ti
You can choos

= W
£ it - _
Nﬁlr vm’?& ! tours com
]o.;.ﬁ—h RS
|
e il
m&m |
e, e |
- b *
www.dell.com o s p——— |
www.olx.com

E-commerce sites are special sites with some extra security features. Trust is one of the key
factors for these sites. Buying products through Internet s very easy and simple. But yy

must not do it alone or without permission of your parents or elders. There are numeroy
companies which sell the products and

services but actually they are fraud. They B
may steal the credit card codes and PIN = *™°

1
and you may run up with huge bills on | =
credit cards while you might have
purchased products for a few hundred "
rupees only.

Some of the popular E-commerce sites are:
WWW.amazon.com
www.ebay.com o : Sl
Www.automart.com

P |
www.indiatimes.com J

\
)
N4

Ve

¢

You have studied about Internet in your previous class. It is the largest computer network. It
contains millions of computers.

Internet is very useful to us. It helps in sending e-mails. You can find information on almqﬁt
every subject on Internet. It is like a big library. You can exchange views and ideas with
other people. Let us learn some of the uses and services available on the Internet.

| 110|
m Fllllfl!lr}glum

4




gducation

Many cducational wsnages from all over (he
facthty - Intemet makes 1t posahle
sudents are not necded

world nowaday s provide onhne cducational
O Team mean convnonment where the teachers and the
AEthe same place o ma classtoom: Some mstitutes conduet online
festy forthet vourses Ny e APPEar mean exam brom vour home sty i front ot your
computer with suaply an Internet connection, ‘

Distance eduention hecoes Casie

vand aftordable with the use ol Intermet

®
-

| PSR A —
Bring Home PAWS e Fun foy T

| A"

| TV . m
hm S g

m:-.'y

L.@m‘*‘ ﬁ‘r J—

www.leapfrog.com www.e-learningforkids.com

Searching Information
Internet 1s like a big library, Information on almost cvery subjeet s avatlable on the Internet.
More and more websites are coming up with the sole aim of providing mformation to people,

be it about people, country, universe, food and cooking, books, movies. history and a lot
more.

You can search for information and visit sites which provide different types of information.

- - -
¢ 0N 0 v A . "
ﬁw-im.c-mm L\‘d- 1r1t1|ﬂ.l1‘R!t?lI[2?l Vldll\.‘ . E § ‘ .

— - R e em—
[ Bewyh |t b e Bhagh 1 g el | o (SR —— (9 "

. WORLD MAP i
" 1 -

b e Rl I S a - g ——

H e TR N -

.“.m (hi\h.ll'l I.I': _‘V_"" il |nd‘|-u l?a-!.l."._‘lh. Aeviews * r \J 2

:u---uum- f— . -~ iTh DE S ¥ ol L

— o I

Imu—-uw‘n e, . o = | " P
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L el S WX, . =

www.food-india.com www.mapsofworld.com

Newsgroups

There are thousands of places on the Internet Where you can exchange views and ideas on
different subjects with other people. These places are called newsgroups. You can Join any

newsg »f vour interest.
ewsgroup of y A @
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i ] ~<th ar Ta vy T thece MmesKiaces 7 -
You ca- ¢ad messages posted Dy other peopic. repihd [0 HICSS MESSATTS, Post Queg
- 8 = i . < = plR § 11
regarding something. and so on. You car search newsgroups of YOUr Interest ysip,
-l — i1l - eil . al. - 4. — 4 l_\ \_C\
E E S gy
»CArch <nigZunes

Www.newsgroups.com www.giganews.com

Most of the newspapers nowadays have an Internet version. You can visit these newspapery
So. using the Internet you can have access to newspapers from all over the world.
Some online newspapers are:

www.hinduonline.com

WWw.nytimes.com

www . kidnews.com

=5 PR
hindustan areraieall
- e A
ba o4 & ol
—
-
I Unbeatable Prices
for 3 cuyl only

b §

———

www.hindustantimes.com www.bbc.co.uk

Ny QD

=

You can find people on the Internet. You can find your classmates, relatives and other gred
personalities. There are sites which offer this facility.

You can find their addresses, telephone number, e-mail ID, etc. provided that the person I
a profile on the Internet.

1112
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e other popular people-finder on Internet are:

www.whowhere.com

www.freeality.com

1l

ecal ty.com
Internet Search Engines

Search Tools

www.whowhere,com www.freeality.com

o el o

g.Greeting Cards
you send greeting cards to your relatives, friends. You can send greeting cards through
[nternet in the same manner as you send e-mails to them.

There are several sites, which provide this facility. E-greeting Cards are both free and paid,
ie. you can send greeting cards for free as well as by paying money. There are cards for all
occasions and for all seasons.

Some of the popular E-greeting cards websites are:
*  www.amazon.com
® www.e-cards.com

[

ke e T S -

M ] :
AaKE yaoul :
} i

1PFING

l

{

P gnn . 3 o2 1RBAALLT Huen) — i

1 Ao L PhotanDesign :rm::r;:«‘w ‘ :; ! i
. ), - = S

v 9 | '

bt £ : !

A, |

J

www.e-cards.com www. hallmark.com

| e o gl

www.123greeting.com | ey |
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WWW posteards.ore
waww bluemountain.com

waww. hallmark.com

Video Conferencing

Video Conferencing is one of the most
exciting features of Internet. Two people
from different places can talk as if they
are sitting in front of cach other, seeing
cach  other, using video conferencing.
Video conferencing is used widely in big
compantes, TV shows, chatting, ete. It
provides a face to tace conversation with
different people who are at difterent

Sudnons. It 1s gaining popularity day by — _\h*. Ll i
av.

Video Conferencing
Downloading

|
-,

P
T =
o

Downloading is the method by which you access files, soltware, information from d remgy
computer using Internet. When you access a website or webpage, yvou actually downlogg the
text page and all the images and graphic from the main computer where all these are storeq
You can download materials from Internet. There are numerous application softw
are marked for download. There are many sites that provide downloading. You can

games. movie trailors, songs, picture images, etc.

are which
downloyg

There are special software available to download files from the Internet. They are called
downloader.

W EmVEE. MW e UAs oW Y

.- M R (LT

v Dmm_;lluad com

PMathonm

GIVETADAY,
SAVE TOMORROW,

O sk
.

gy DOMNATE *;_“.-_M
8 st Star Apps: James lha
" The gueaist 0roves Ne s 0o deades! post Smash ng Pumpking Moat Popukar Download s
oy ¢ Flead mois
1 ast Froe Antivirgs 2015 BT}
Bovular Lia ﬁ‘i VirtualBox Avira Froe o XiView U Auastbnse Antvins 201 1
RS Mant g Antivirus Manage ¥ AR TRETOLS a9
BARPRT MyMiply Detect and abmoae g Mg o s
IR AN PR T} haspg Ve 114 Dok
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I 114| www.download.com
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phese software provide a very casy-to-use way to download files. Some ol the pop
. 3 NS A
Jon nloaders are

¢

]
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#
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Getright

Netants

Internet Download Manager

Nitro Downloader
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|
|
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Getright Internet Download Manager

Itis the same as if buying products using mails. There are several sites, which offer shopping
on Internet. You are just required to select the desired product and fill up some fields in a
form. You need a credit card for this purpose. Some of the shopping sites are:

Ly

&
€
]

www.walmart.com
WWWw.amazoon.com
www.indiatimes.com
www.rediff.com

“ 4 xa

Wwviwn - Bwprs B 0 esyin s B ritinns e stk [ TS

Walmart > <

Hurry! 1hgse
Are o fast °
i ;
o inlabinies Eoi www.walmart.com
CHATTING '
Using the chat facility on the Internet, you can talk and communicate with people all around
the world in no time.

Computer3clancs '
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oftware availal,
There are many sites w hich offer chat facility, There are shLIL Ilt;llll‘:l"lhu people O“II:“L i
Instant \[essenoers You can log on to them and chat W ith va asily: simply by ‘)’Hne
chat software is an interactive soﬂ\\ arc and you can chit VEry & L
box and pressing Enter key.

Some of the popular chat software are: | fiea | T
Yahoo Messenger P | \tq
Windows Live Messenger |~
Rediff Bol
ICQ r‘

To use these software. you g

must install them in your ||

computer system with Internet
connection. You must also have L ca oo
a user account. | | o

| L |
\ std Fecder} | ::

z Chatting can be fun as well as |‘ s .
waste of time. It depends || I
upon how you use it.
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TR the i aptiom
C e peaple tvalved winly T

Llhalll | (h)p A types

it} Bkyrs Ly 2 e

People who e hase o e

() weeller C by huyer

(1 “””"”""" (rl]nmwnllhl".i'

I A T R Y

(o) Vitlo e Hessonme e Lo aton [ () Uniform tesonrce Location

() Uhndcode Tesomce Lot || Ly Hone of these
0 You can tallorg people Lce to faece tsing

() 15 il ;o (h) Daownloading

() Video Conterencing, C o (d) Chatting, :
S nternet coned va send cards calledd

() Credit Condy, L (b)) Visiting, Card:,

() B Greeting Cande, | (d) None of these
FILLin the bEankes with the eprrget word,

Online  free  buying — Ecommerce  paid — Producers  selling
I Commerce imvolver and of i product
are people who protduce products,

I preetings are both -
FoSecurity and trast are the key factors in

I commerce is huying and selling products
State whether the following statements are true or false.
L The web address is also called a URL, L
2 Video Conferencing is one of the most boring features of Internet, |
L Special software available to download files from the Internet are called

uploader |
1 You can find people on the Internet. 1

W Distance education hecomes harder and unafforadable with the use of
Internet. .

Answer the following questions.

' What do you mean by i commerce? Write some advantages of E-commerce,

Computer Scieace
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Define Producers, Sellers and Buyers.

Prepare a list of various websites according to their usefulness. Also categoriseq ,
websites into various types according to the information they provide to the users.

= s e

e = ———
S ———

-/ Visit some E-commerce sites and prepare a list of products available there.
/ Purchase some items online with the help of your elders. [Note : Never try it yourself
N alone].

) Visit a site which offers free download for games.

s Visit some websites which offers online learning facility.
> Download some of the songs using downloader software. Note down the time taken for

downloading.

- Visit a Internet cafe with your friends along with some elders. Chat with each other using
Yahoo Messenger or Rediff Bol or any other chatting software.

& Compuler Science ;
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PROJECT WORK
—

Project 1

create an Excel sheetto calculate the sales of Swift and Celerio of 1) Sneh Auto India P fita

. Formatthe spreadsheetand design itas given below.

To calculate the revenue of Swift for the month of January, enter the formula as grven helow

The fOI“mUIa Wl” mu]tlply the ]]umh(‘xr Uf‘ units ‘i”ld Wlth the [””'“ pr:] unit using f‘-h'.fjllnf'
referencing.
Copy the formulatorestofthe cells.

A B | € | D E F G oo
Months' | Unitsof | Unitsof Revenue Revenue  Total | Maruti ' Maruti
Name Maruti = Maruti of of Revenue Swift Celerio
| Swift = Celerio Swift Celerio pPrice  Price
- ; _S_old Sold _
1 | January 2 4 =C4*$H$4 () 575000 4274000
2 February 3 6 () |
3 | March 5 3 0
4 lAprii' - 6 4 0
5 | May 8 6 0
6 |June 4 7 0
7 gy 8 0 0
8 | August 2 5 0
9 Sepzeﬁiber 6 1 0
10 | October 0 7 0
11 | November 2 6 0
o Tosomier | 9 | ;
| TOTALNO.OF UNITS
TOTAL ANNUAL TURNOVER

Similarly, enter the formula to calculate the Revenue of Maruti Celerio.

Calculate the Total Revenue by adding the Revenue of Swiftand Celerio using formula.

Now copy the formula to calculate revenue forall the months.

In the ‘Total Annual Turnover’ section, enter the formulae to calculate the total turnover of the
year by adding the turnover ofall the months.

. Calculate the total number of units soldin the whole year.

Create a Pivot Table for the given worksheet.
Now create a chart to compare the sales of both cars. —
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ed Species 11 MS | |
| he taken Lo savi

Make o beautiful project on Save Endanger

purdelines add more slides that reflect what steps Hlligl

A

An endangered species is one that is getting close to
extinction. This is the endangered black rhinoceros

" that lives in Africa

(3]

| The African elephant, the largest land animal on (
Earth, is also a threatened species. Thousands of |
these majestic animals have been slaughtered by
poachers, who cut off their ivory tusks *u make

|

carvings and sell them for money.
L % }

REASONS why
PLANTS and ANIMALS
become endangered
or threatened. The
biggest reason 1s loss
of their homes or
habitats. Endangered ’
species are in trouble,
because of pesticides /
and pollution,
competition with
other non-native
species in their
habitat, diseases and

Ways That species

Become Endangered

I. Habitatloss

2. Unregulated or illegal
killing or collection

3. Pesticides, pollution

4. Competition with ether
species

5. Disease

6. Predation

predation. JI
: e )
120|
-_— L‘lllll'l_l' Science

owerPomt. Apart trom .

1 i
these endangeres Do,

| il

‘-[}l'l 1y :
hire alarms
| w7
tell us '!l“”l'
'.'luhll'?rn In oyp
home we call
Earth, [f we
. listen (5] [h[-“
alarm calls, 1,
. ‘}
could help yg
IMPrOve our |y,
and the healty of
our plang

Endangered means
There's Still Time

The spotted owl is
our hire alarm to
the problem of
over-cutting of
forest. To resolve
this problem,
agencies are
working on plans to |
manage spotted |
owl habitat better
by monitoring
timber harvest
levels more closely.

DEFINITIONS

Extinct

A species of plant or animal that is no longer
’ living.
Endangered :
A species that is in immediate danger of
becoming extinct and needs protection 0
survive.
Threatened
A species that is likely to become endangere¢
ifitis not protected
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10.

1,
12
13,
14,

| 1.

16,
17,
18,

19,

WORD INDEX

4

ANIMATION: It refers to the special effects added to the objects and text in a

CLIENT: Itis a computer connected to the server in a network.
CHART: Itis a graphical representation of information.

ceLL REFERENCE: It identifies the location of a cell or group of cells in the
spreadsheet.

E-COMMERCE: It is the online trading or exchanging of goods.

FILE SERVER: It is a computer that manages the storage and retrieval of files.
FORMULA: It is written with operands and operators.

FUNCTION: It is a pre-defined formula of MS-Excel.

HUB: It is the central connection point in a network.

HORIZONTAL SCROLL BAR: It helps to scroll either to the left or the right of the
screen.

LOOP OR ITERATION: It is repetition of statements in a program.

"MENU BAR: It js the bar present just below the Tittle Bar.

QBASIC: It stands for Quick Beginner’s All-Purpose symbolic Instruction Code.

SERVER: It is a computer that manages the other computers, database and
printers required in a network.

STATUS BAR: It displays the status of the current position of the cursor and the
short-cut keys for frequently used commands.

TITLE BAR: It displays the name of the program running and the file name.
TOPOLOGY: It is the physical arrangement of computers in a network.

VERTICAL SCROLL BAR: It helps to scroll either to the beginning or to the end of
the screen,

WORKSTATION: It is a computer intended for individual use in a network.

|121l

A ‘ l:nmn;l::::lnncu o —



.

‘e

he first PC Virus was a Boot Sectol
Virus called BRAIN, developed in 1987
by two Pakistani brothers Basit and
Amjad Farooq

Microsott Windows 8 15 the latest
upcoming version of Windows.

August 12, 1981 marks the birth of the |
IBM-PC, the computer that changed the

. world, ‘

The first version of Windows was
Windows 3.1. It worked under DOS
environment and was introduced in
the year 1990, '

In 1953, the first high-speed printer
was developed by Remington-Rand
for use on the UNIVAC computer.

CDMA (Code Division Multiple
Access) 1s a type of 3G cellular
network. CDMA is the higher speed
transmission protocol used in the
Japanese FOMA system.

The CHIP-4004 was the world's first
universal microprocessor.

The first LAPTOP was released by the ‘
Osborne Computer Corporation in

5 1981

i
1
|

)

&)

pij kL Y%

701 EDPM firy

v successtul general puyp.

was  the

IBM's
commerviall
computer developed n !!1“- vear 1951 1,
could be rented tor $ 15000 pm

The fitth generation ol computers yy|
be able to provide knowledge and w|

\ be known as XPRESS.

Bluray Disc 18 a nextgeneratoy
optical disc format that enables h
ultmate high-detimuion entertaimmeny

experience.

The most popular digital music player
in the world—iPod was mtroduced by
Apple in 2001

SPACEWAR was the first interactive
computer game

TATA

Gompnipr Science

Bogks £,

The Global System for Mobile
Communications (GSM) 1s the most
popular standard for Mobile Phones
in the world. GSM service is used by
over 2 billion people across more than
212 countries and territories.

Apple was founded on April 1, 1976 by
Steve Jobs along with Steve Wozniak
and Ronald Wayne. Apple introduced
Macintosh—the first user friendly GUI

The biggest software company i India
1s Tata Consultancy Services | ICS).



PERIODIC TEST Term (1]

(Based on chapters 110 4)

Time Mearhs
Note : All questions are ompulsory
A. Ti('k(/)Ilwrighluptiun.
With anetwork, it is possible to share
(@) Printers L (b)Modems L [€)Soltwares L (d)ATTofthese
Nographicsbhe created in.......... mode
(a) Screen 2 [ ] (b) Screen s | l{r)h‘t‘]‘vvn 0 | _ “:l]#&rn-t'nl [ |
'l'tl|)t'|'l'nrm(livisinnnl'llin;u'ynumln-rs,:livi(lvllu-numlwrhy
(a)2 C (b4 G __ (d)Noncolthese |
B.  Fillintheblanks with the correct words.
! (l(‘lallnumlwrsyslvmt'unsislsnl'.'............‘......tli;;ils.
+ Basicwas designed by professor . AR in 1904,
N, topology, all the workstations are connected to the central hub.
......................... numbersystemis understood by the computer system.
C.  State whetherthe following statements are true or false.
InClient-Server network, there is no central server, L !
' Thenumbers used in Octal number systemare 1 to 7. L_- ‘
The Circle statementis used to draw a circle. [ ‘
i Acomputer networkis a collection of computers and other devices. B i
D. Answerthe following questions.
Whatdo you understand by the term screen modes?
Listsome advantages of networking.
E. Solve the following Binary numbers.

10010-01000
10101+00111
1011 x 101
1111+11
111001 + 101

4123

‘ Compular$cience
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m Test Paper ﬂlﬁ‘l

(Based on chapters 1 to 6)

Marks : ...
ﬁ_‘:

............................

Note : All questions are compulsory.
A. Tick(v')theright option.
L. Ona...allofthe computers and devices on the network connect toacentral device
(a)busnetwork [ (b)ringnetwork [ ] (c)starnetwork | [dpnaneatihasel 7
2. InBinary,subtraction 1-1 equals

(a)10 L ()0 ] e L @1 e
. The..nnen, statement displays message or output ofa program.
(a)CLS ] (b)PRINT ] (€)GOTO | (ENTER
4. Astatementshifts the control back to the WHILE statement.
(a) WHILE __ (b)WEND __, (@Do i (d)NEXT .
5. Themain area ofthe MS-Access Interface is divided into .................. Sections.
TR s (@) two ] (b) three [ ] (9)five [ ] (d)four L
, B. Fillin the blanks with the correct words. ‘
L erensseneenans technology isaform of wireless communication.
2. BinaryMmeans....ovauimii 3
3 sesasissnen command allows us to enter information when the program is being
executed.
4. The e statementis used to draw a straightline.
5. RDBMS StaANAS fOr ..ottt na s ssssssens .
C. Statewhetherthe following statementsare true or false.
1. Tables,queries, reports and forms can be created in MS Access. [_ :
e 2. Wecandeleteafield in Design View. - E_— _

'WEND clause is used with FOR statement.
4. Integer constants are only positive numbers.

I

o8]

5. Decimal i.nmhersystem has base 10.
D. Match the following.

uE
|

| 1. Number (&) createsunique values automatically.
2. Text (b) canstorenumericdataonly.
3. AutoNumber (c) storesvaluesinamonetary formats.
t. Yes/No (d) cancontainvaluesthatare text,numbers or both.
5. Currency (e) logical dataused when only one of two options is valid
| e |
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Answer the following questions.
I Whatisatopology? Give example.

2. Whydowe use Binary Number System in computers?
Whatis the use of PSET statement?
1. Whatisnestedloop?

3

wu

Give the difference between

(@) Numberand AutoNumber data type
(b) DatasheetView and Design View
Give full forms of the following,

-

b .,,MW'!'F'

L. HTTP 2. SMTP e
3. FIP 4. LAN
5. WAN 6. MAN e
7. Wi-Fi RER——— 8. TCP et
G. Lookat the picture shown below and label the different parts of MS-Access Database
Interface window.
\ o "'!5 w}
| O ‘p-'—‘-— . 1 %Pmabaul Da1abne(i\ct!$s M= Table Tooks _i
| J " Home Create External Data Database Tools Acrobat Datashes
i " . i o : elationsh Object EE—
— e “d‘:.i:.;';‘""' gl TNSTPRN e
Views Frelds & Columns Dala Type & Formatting Relationships
.. 3 _-_. - i
§ Al Tables - uJ‘[‘.‘_'.‘r-:r-u:ﬁ\ in - . Alama Mﬂm:
L Tables 2 | ID |Add New Field
R Table1 ; Table " (New)
EE—— ]
| H— | —
t_ || Record. 0 101 M Search )
] Om;e_t;le_w- ' _ oct

-{'l



PERIODIC TEST  Term (2 |

(Based on chapters 1 to 9)

Time : ..., Marks : ......
Note : All questions are compulsory.
A. Tick () therightoption.
The horizontal axis ofa chartis also known as
(a) Catagoryaxis|__| (b) Value axis | (c)Legend L (d) Y-axis
20 s tab allows you to format the pictures and graphics.
(a) Home || (b)Insert || (c)Format || (d)View
3 A

e KEY 18 @ field that contains unique values.

(a) Main L\ (b)Primary | (c)Secondary || (d)]Junior
B. Fillinthe blanks with the correct words.

....................... button is used to record narration for the slides.

s DULtON is located at the top left corner of the Access screen.
2. Pressingthe......o....... key opens the Save As dialog box.
1 " % The...csen Statement is used to draw a straightline.
" State whether the following statements are true or false.

-~ TheBar Chart shows columns with a conical shape.
2. Aworkbook can contain any number of worksheets according to user’s need.
“. Adatabaselocates information with the help ofasimple query.

4 1multiplied by 0 equalsto 1.

D. Answer the following questions.

. Whatare the stepsinvolvedin modifying thelabels and titles of a chart?
\ 2. Howis MS-Access different from MS-Excel?

E. Identifythe typesofchartand nameit.

gz E
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m Test Paper 'HEH"HH'”JH

B e L% £ L L ——
Note Al guestions ane compulsory.
A Tk (v ) theright option.
L Nhdeshow optionis there inthe oo, tab.
() View C o (b) Home L1 () Insert || (d) None of these ||
2o The s statement displays message or output of a program.
() CLS __{ (DY PRINT L (©)GOTO . (d) ENTER 4
30 Chp Artis 0 file that can be inserted ina worksheet.
(1) shape | (B picture L () figure L] (d) text L]

4. Vertical Axis of the chart is also known as
() Category axis (b)) Value axis __ (¢) Legend __| (d) X-axis
5. Which panel acts as a store house in Flash?
() Library __| (b) Tools | | (¢)Properties || (d) None of these L
B. Fillinthe blanks with the correct words.

LooThe s field type is used to store web address.
2. By detault, a worksheet containg ... worksheets in MS-Excel.
3. In Binary addition, 1 + 1 equals to .., ;

A formula always begins with an ... sign.

4.
5. E-commerce is buying and selling products ........... e .

C. State whetherthe following statements are true or false.
1. Thebackground color code for Gray coloris 7. = ;
2. Formula can be entered in the Tool bar. lﬁ |
3. The function library is a small group of functions. [ |
4. Looping technique reduces the number of instructions. ] il |
5. Special software available to download files from the Internet are calied uploader. \ ”

D. Matchthe following.

Show type a) Select number of slides

Show options b) Full screen/Window view

d) Graphics acceleration

1 (
2 (
3. Show slides (c) With or without a narration or animation
4. Advance slides (
5 (

Performance ¢) Manual or automatic change of slides

| g |
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E An;werthefollowingquestions.
' Whatis the use of PSET statement?
¢ Differentiate between a workhook and a worksheet.
° Whatis a chart? Why are charts useful?

Write any four advantages of a datahase.

How is Internet helpful in education?

F. - Circleanyten termsrelated with databases in the following grid.
S

G. Labelthecomponentsofthe Flash Window shown below.
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